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Introduction

What is CentreWare?
CentreWare is a suite of applications and printer/fax drivers that support the Xerox 
Document Centre line of products. With an array of Administrator and user tools, 
CentreWare is used for installing, maintaining, and using the Xerox Document 
Centres.

CentreWare Services consists of:

! Network Admin Services

For installing and configuring Document Centres for printing/faxing in NetWare, 
TCP/IP, Microsoft Networking, and Banyan VINES network environments. 
AppleTalk environments are supported by the Mac Printer Utility.

! Network Print/Fax Services

For installing, configuring, and using Document Centre printer and fax drivers. 
Also includes network printing and productivity tools like the Conductor, Fax 
Phonebook, and TIFF Submission Tool.

! Network Scanning Services

Used to scan documents to file, fax, E-Mail, and other third-party applications, 
such as PaperPort and TextBridge. 

CentreWare Internet Services is the embedded HTTP server application that allows 
you to access printing/faxing/scanning, connectivity, and maintenance tools using a 
web browser. It has features that parallel the Administrator and user tools of 
CentreWare Network Services, but it uses the browser interface instead of the 
standard Windows interface.
xi
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Figure I-1:  CentreWare Network and Internet Services
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Who Should Use This Guide
This guide is written for Network Administrators who need to install, set up, and 
manage Release 5.20 CentreWare Network Scanning Services software on their 
networks. To use the procedures in this guide effectively, Network Administrators 
must have previous experience working in a network environment and must possess 
Supervisor, Administrator, or equivalent rights to the network. They must also have 
prior knowledge of how to create and manage network user accounts. 

This guide provides network scanning users with information on how to create scan 
templates, use watch services, and scan documents. To use this guide effectively, 
users must possess a basic understanding of Microsoft Windows software and of their 
network environment.

What’s New in This Release?
The CentreWare 5.20 Network Scanning Services software and documentation 
include the following updates and revisions: 

! Support has been added for Document Centres 420/432/440 and 460/470.

! A new service module which can be installed to support scanning to Microsoft 
Exchange folders.

! Template features have been updated to support new options.

! The documentation and help have been updated.
Who Should Use This Guide xiii
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How To Use the Documentation Set
The documentation for Network Scanning Services includes the CentreWare Network 
Scanning Services Guide, the CentreWare Network Scanning Services User Guide, 
the CentreWare Network Scanning Services Help Centre, and context-sensitive Help. 

CentreWare Network Scanning Services Guide

The CentreWare Network Scanning Services Guide provides Network Administrators 
and scan users with information about using the CentreWare Network Scanning 
software on Microsoft Windows workstations. It includes step-by-step instructions 
for performing both Administrator and user tasks. 

A hard-copy version of this guide is included in the product package. An electronic 
.PDF version can be found on the Network Scanning Services CD.

CentreWare Network Scanning Services User Guide

The CentreWare Network Scanning Services User Guide provides scan users with 
information about using the CentreWare Network Scanning software on Microsoft 
Windows workstations. It also includes step-by-step instructions for performing user 
tasks. The User Guide is provided in .PDF format only and can be found on the 
Network Scanning Services CD. 

NOTE: The Adobe Acrobat Reader is required to view and print the PDF files. 
Readers for all environments are provided on the CentreWare Network Admin 
Services CD in the \ACROREAD directory. Acrobat readers are also available free 
of charge from Adobe at www.adobe.com.

NOTE: Information about network scanning from non-Microsoft Windows 
workstations can be found in the CentreWare Internet Services Guide.



Network Scanning Services Help Centre

The Network Scanning Services Help Centre is the central online source for scanning 
information. It includes feature descriptions, step-by-step procedures, problem 
solving information, a glossary, and support information.

The Network Scanning Services Help Centre is automatically installed on the 
workstation during the software installation. The Help Centre can be accessed in the 
Xerox CentreWare programs list on the desktop.

Help

Context-sensitive Help contains feature information about the Network Scanning 
Services software and detailed instructions on how to use it. Help can be accessed by 
using either the Help buttons or menus in the scanning software.

Figure I-2:  Network Scanning Services Help Centre
How To Use the Documentation Set xv
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Where to Get CentreWare Support

Internet Support
Visit CentreWare on the Internet at www.centreware.com. Our web site contains 
product support information, product demonstrations, and the latest information about 
CentreWare updates and new releases.

Telephone Support
For additional assistance, you may contact the Xerox Welcome Center by telephone. 
Locate your Document Centre serial number, and record it in the space below before 
you make your call.

The Xerox Welcome Center telephone numbers are listed in the following table. If the 
Welcome Center telephone number for your country is not listed, it will be provided 
to you when your Document Centre is installed. For future reference, please record 
the telephone number in the space provided below. 

Document Centre Serial Number:

Welcome Center Telephone Numbers:

UNITED STATES 800-821-2797

CANADA 800-939-3769 (800-93-XEROX)
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Introducing Network Scanning Services

This chapter explains the concept of network scanning versus traditional scanning and 
introduces the CentreWare Network Scanning Services software. It also contains a 
section to help users of previous software versions adapt more quickly to the new 
software. 

What is Network Scanning?
Traditionally, scanning a document meant that you could place a paper document on a 
scanner attached directly to your PC and obtain an electronic image of that document 
on your PC desktop.

Figure 1-1:  Traditional Scanning
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CentreWare Network Scanning Services enables you to scan documents at the 
Document Centre and create electronic TIFF files which are sent to a document folder 
(a specific directory) on a file server. These files can then be:

! automatically sent to a user’s workstation and opened with an application that is 
capable of reading TIFF files.

! moved to a user’s PC or another server location for storage.

! kept in the document folder with notice sent to the user that the scanned 
documents are available.

! distributed to other people via E-Mail.

! converted to another file format such as .RTF, .PDF, .HTML, .TXT, etc.

! automatically faxed to others.

! scanned directly into PaperPort on a user’s desktop. (You must first install the 
companion Scan to PC Desktop™ package.)

Figure 1-2:  Network Scanning
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How Can Network Scanning Help You?
CentreWare Network Scanning Services combines the power of Xerox Document 
Centre scanning with the software applications you use every day. Network scanning 
enables you to improve your work processes and save time and money.

Here are some of the ways network scanning can help you:

! Scan to your desktop—Scan paper documents and retrieve them automatically at 
your desktop with PaperPort software. (Requires Scan to PC Desktop™ software 
package.)

! Scan to E-Mail—Scan documents directly to your E-Mail system. Reduce the 
cost of overnight mail delivery.

! Redesign your records storage—Eliminate paper piles and walls of filing 
cabinets. Now you can store your documents online.

! Eliminate time-consuming retyping efforts—Stop retyping older documents or 
recreating complicated graphics. Simply scan the paper copy, convert your 
document to Microsoft Word, HTML, .PDF, ASCII, or many other popular 
formats, and make your changes. 

! Share documents and information quickly and easily—Store scanned documents 
in a common directory folder where co-workers can easily access them.

! Quickly prepare time-critical proposals and presentations—Include data from 
different sources and incorporate it into a common format to create professional 
presentations and proposals! 
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Features At A Glance
Network Scanning Services is composed of several different elements that work 
together to create and deliver the scanned document to its final destination.

Xerox Network Scanners Window
The Xerox Network Scanners (XNS) Window is your starting point for all network 
scanning activities. When you open the XNS window, the names of all scan-enabled 
Document Centres that can be accessed from your workstation appear in the list. If no 
Document Centres are enabled for scanning, only the Add Network Scanner icon 
appears in the window. 

Figure 1-3:  Xerox Network Scanners Window
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Add Network Scanner Wizard

The Add Network Scanner Wizard is both an administrative and user tool. Network 
Administrators who possess Supervisor or Administrator rights on the network can 
use the Wizard to install and set up Network Scanning Services. Scan users can 
automatically locate configured scanners on the network. Some of the tasks that can 
be performed with the Wizard include:

! installing the scanning software on a network file server.

! enabling the Document Centre to log on to the scan server and access distribution 
templates and document folders. 

! granting network users access to network scanning and creating default scan 
templates for each user.

! optionally creating scanning groups which allow several users access to the same 
Document Folder (NetWare and NTFS networks only).

! automatically locating scanners on a network.

Refer to the installation chapter for your network environment to obtain more 
information on using the Add Network Scanner Wizard. 

Distribution Templates
Distribution templates control the manner in which a scanned document is processed. 
They contain specific instructions that define the electronic document’s format and 
details about how to file, fax, or distribute a scanned document. A default distribution 
template is created for each scan user at the time Network Scanning Services is 
installed.
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Distribution templates are stored in a template pool on a network server. Templates 
can be created once and used repeatedly. The Add Network Scanner Wizard can 
configure each Document Centre to download distribution templates from a 
networked template pool. More than one Document Centre can access a single 
template pool; however, this practice is not recommended. If a template is modified or 
deleted, the changes will impact the template’s use from all machines.

Refer to Chapter 7, Distribution Templates, for more information.

Figure 1-4:  Distribution Templates
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ntroducing Network Scanning Services



Watch Services
Watch Services (also called the Watcher) enable you to monitor a network directory 
(document folder) for the arrival of new scanned documents. You can also specify 
how the document will be processed once it appears. A document can be: 

! moved to another directory or folder.

! opened on your PC desktop with any application able to read TIFF images.

! stored in the document folder with notice of its arrival sent to your desktop.

A Watch Service is automatically established to monitor each scan user’s document 
folder when Network Scanning Services is installed. 

Refer to Chapter 8, Watch Services, for more details.

History
The View History option available from the Xerox Network Scanners Window 
enables scan users to view a summary of the activity performed by the CentreWare 
distribution server. 

Refer to Chapter 10, History, for more information.
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Properties

Scanner Properties

The Scanner properties are available from the Scanner menu in the Xerox Network 
Scanners window. Scan users may view scanner properties. Administrators can 
quickly view or modify scanner properties. Use scanner properties to access:

! network scanner status

! distribution information

! Document Centre network login, password, and advanced Document Centre 
settings

! completed jobs information

Refer to Chapter 6, Managing Scanner Properties, for more information.

Distribution Template Properties

Distribution Template properties can be accessed from the distribution template 
window. Templates can be modified by anyone with Write access to the template 
pool. By default, all enabled scan users have Read/Write access to templates.

Refer to Chapter 5, Managing Scan User Access, for more information.
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Getting Started
The Xerox Network Scanners (XNS) Window is your starting point for all network 
scanning activities. 

Opening the Xerox Network Scanners Window

You can open the XNS window in either of the following ways:

! From your desktop, select:
Start > Programs > Xerox CentreWare > Xerox Network Scanners

- OR -

! Double-click the Scanning icon in the Windows taskbar.

adds scanner icon to taskbar and 
initiates scanning applications 
running in background

scanning icon in Windows taskbar
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Understanding the Xerox Network Scanners Window
When you open the XNS window, the names of all scan-enabled Document Centres 
that can be accessed from your workstation appear in the list. If no Document Centres 
are enabled for scanning, only the Add Network Scanner icon appears in the window. 

Figure 1-5:  Xerox Network Scanners Window

NOTE:  Refer to Chapter 12, Problem Solving, if you have scan-enabled 
Document Centre scanners installed on your network that do not appear in the 
Xerox Network Scanners window.
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Scanner Menu
The Scanner Menu contains all of the menu functions specific to network scanning:

The Edit, View, and Help menus all contain standard Windows options. 

Add Network Scanner. Enables Network Administrators to configure 
Document Centres for network scanning.

Uninstall Scan Server. Uninstalls scanning software and document 
folders from scan server.

Watch Folder. Opens a dialog displaying document folders for 
monitoring. This item is disabled unless a network scanner icon is 
selected.

Open Templates. Opens a window which lists the templates associated 
with a particular Document Centre. This item is disabled unless a network 
scanner icon is selected.

Explore Documents. Opens an Explorer window of your document folder on the scan server. If 
you are logged in with access to multiple document folders, Explore Documents opens the 
\data\users directory on the scan server. From there, you can select the desired document 
folder and examine the documents inside. This item is disabled unless a network scanner icon is 
selected.

View History. Opens a window which displays a record of distribution scan jobs and their status 
(processing, completed, completed with errors, or failed). Jobs for all users are displayed in the 
window. 

Manage Users. Enables Network Administrators to quickly add or remove new scan users or 
scan groups.

Delete. Removes the selected scanner from the displayed list and local cache. It does not delete 
the scan server or any information contained on the server. This item is disabled unless a 
network scanner icon is selected. For Network Administrators only, Delete also prompts you to 
uninstall the scan server and restore Document Centre settings to factory defaults.

Properties. Allows all users to view device-specific scan settings. Also allows Network 
Administrators to establish the distribution server or to modify device-specific scan settings.

Close. Closes the Xerox Network Scanners Window. 
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Transitioning to the 5.20 Software
If you have been using release versions 3.2 or 4.1 of the CentreWare Network 
Scanning Services software, this section is for you. (If you are currently running 
release 5.1 software, you do not need to read this section.) You will notice several 
changes which have been implemented to make the scanning software easier to use:

! New Look and Feel

The scanning software has been redesigned so you don’t have to open several 
different software applications to perform the scanning tasks. Every task is 
started from the Xerox Network Scanners window.

! What Are Distribution Templates?

Distribution Templates are what were previously referred to as templates or scan 
templates. The name has been changed to better convey the functionality. 

! How Can I Change Template Settings? 

The former Template Utility functionality has been incorporated into the process 
of creating or modifying distribution templates. Distribution templates can be 
accessed from the Distribution Template Window.

! What Do I Do with My Existing Templates?

Existing Scan-to-File and Scan-to Fax templates can be used as is. Since 
CentreWare 5.20 uses an "Inbox" directory for all distribution processing, E-Mail 
templates and templates that include Optical Character Recognition (OCR) 
require special attention. These templates can be handled in two different ways: 

! Use the CentreWare 5.20 Watch and Move features to move documents from 
your existing E-Mail and OCR directories to the CentreWare Inbox directory 
on the scan server.

- OR -

! Open the templates from the CentreWare 5.20 Distribution Template 
Window, save, and close the templates again. The software updates the 
templates to file to the CentreWare Inbox. Once there, distribution is 
managed by the CentreWare 5.20 distribution server. The distribution server 
must be set up by the Network Administrator during installation.
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! How Do I Set the Document Management Agent?

The functionality of the Document Management Agent has been replaced by 
Watch Services and Distribution Services. When the scanning software is 
installed on your workstation, a service is automatically set to monitor or "watch" 
your document folder on the scan server. The Watch Folder Wizard offers 
enhanced functionality compared to that of the former Document Management 
Agent because it enables you to watch multiple folders on a network and to 
choose among three different functions to perform after a document is detected in 
the folder. See Chapter 8, Watch Services, for more details.

Distribution Services have been simplified as well. Scanned documents requiring 
distribution services such as OCR or E-Mail are sent from the Document Centre 
directly to the Inbox directory on the Scan Server. Once there, the CentreWare 
distribution server picks up the document and performs the necessary services.

For more information, see Chapter 4, Enabling Scan to E-Mail and Distribution.

! How Do I Create Remote Repositories?

Creating remote repositories is no longer an Administrator’s task. Because the 
flexibility of setting scan destinations has been greatly enhanced in this version 
of CentreWare, you can now simply create a distribution template with a "scan to 
other" destination. The other destination can be any location to which you have 
access. See Distribution Templates on page 7-1 for more information.
Transitioning to the 5.20 Software 1-13



1-14
 Introducing Network Scanning Services



2

Installing Network Scanning Services
on NetWare Networks

This chapter contains system requirements, information to help you plan your 
installation, an installation overview, and detailed procedures for installing the 
Network Scanning Services software on NetWare networks. 

A complete installation involves installing and running administrative software to set 
up the scan server, enabling the Document Centre to communicate with network 
scanning software, and installing applications on the user workstations. 

To enable Scanning to E-Mail or distribution, you must also set up a distribution 
server. See Chapter 4, Enabling Scan to E-Mail and Distribution, for more 
information on installing distribution services.
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Key Terms
Understanding the following terms will better enable you to perform the Network 
Scanning Services installation:

Distribution Server.  A Windows 95/98 or Windows NT 4.0 client, Windows 2000 
Professional or a Windows NT 4.0 or Windows 2000 server set up to host automated 
document processing. The type of processing that takes place is based on the services 
specified in a distribution template. The distribution server manages automated Scan 
to E-Mail, OCR processing, and other distribution services. 

Distribution Template.  A distribution template is a component of the Network 
Scanning Services software which contains specific instructions on how to process or 
store a network scan job. The information in the template defines various scan, OCR, 
fax, and E-Mail settings that may be required to complete the scan job. Each user is 
assigned a default template when the Administrator sets up access to network 
scanning. 

Document Folder.  A document folder is a filing directory on a network server in 
which scanned files are stored. 

Scan Server. The network server on which the Network Scanning Services software 
(\CW_SCAN directory) is installed. It typically hosts the scan template pool, user 
document folders, a default scanning repository, and group repositories (if groups are 
supported by the network configuration). 

Template Pool. A directory location on a network file server (the scan server) in 
which scan templates are stored. New templates created with Network Scanning 
Services are automatically stored in the template pool. 
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Installation Requirements

Document Centre Configuration Requirements

! The Document Centre is connected, configured, and functioning as a network 
printer.

! The scanning option kit is installed on the Document Centre. 

Workstation Configuration Requirements

Network Scanning Services software is available for 32-bit environments. The 
minimum recommended workstation configuration is:

Microsoft Windows 95 and Windows 98 Workstations

! 486DX, 66 MHz or higher processor.

! At least 10 MB of available hard-disk space.

! 16 MB of memory or higher.

! CD-ROM drive.

! VGA (or higher-resolution) display adapter.

Microsoft Windows NT 4.0 and Windows 2000 Workstations

! Intel-based systems—Pentium or faster; RISC-based systems—workstation with 
Alpha AXP, MIPS R4X00, or PowerPC processor.

! At least 10 MB of available hard-disk space.

! 32 MB of memory (minimum), 64 MB (recommended).

! CD-ROM drive.

! VGA (or higher-resolution) display adapter.

NOTE: If you are using Windows 2000, check the ReadMe files or the 
CentreWare website for the latest information on compatibility or support.
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Network Configuration Requirements

Scan Server Requirements

The configuration requirements for the scan server in a NetWare environment 
include: 

! any of the following servers:

! NetWare Bindery server (3.1, 4.x, or 5.x (IPX only))

! NetWare NDS server (4.x or 5.x (IPX only))

! a minimum of 2.5 MB available disk space, plus sufficient space to store 
TIFF/PDF files. The minimum requirements will vary based on the number of 
scan users. 

Connectivity Requirements

During scan processing, the Document Centre must make a connection and transmit 
document images to folders on a file server. On NetWare networks, Network 
Scanning Services files scanned images using the NetWare Core Protocol (NCP) via 
IPX over Ethernet or Token Ring. Filing via IP is not supported.
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Security Requirements

Network Administrators

Network Administrators must possess the following network rights to configure the 
scan server with the Add Network Scanner Wizard:

Scan Users

Scan users require network access to the \CW_SCAN directory on the scan server. 
Refer to How Will You Manage Network Security? on page 2-9 and the Summary of 
Access Rights on page A-4 for more information on scanning access rights.

Document Centre Scanner

The Document Centre scanner requires a valid network login name and password to 
gain access to the scanning directory structure on the scan server. You must create this 
account prior to installation using your network administration tools. Necessary rights 
will be granted to the Document Centre account during setup with the Add Network 
Scanner Wizard. 

Network Server Type Required Access Rights

NetWare Bindery Supervisor rights on the target file server.

NetWare NDS Read/Write/Create rights in the target NDS Name Context and 
NDS Volume Object.

Table 2-1:  Summary of Rights Required to perform installation on NetWare networks
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Planning the Installation
Before you begin the Network Scanning Services installation, you should take a few 
minutes to consider how your organization will use the scanning software and 
determine the optimal configuration for your network. Some basic issues to consider 
are outlined below. 

What Scanning Functionality Do You Need?
Network Scanning Services gives you the ability to install and configure different 
scanning capabilities based on your organization’s needs. You can perform four basic 
scanning functions:

! Scan to File (Document Folder)—Scan a document and store the electronic 
version in a specific document folder (directory) on a network file server. This 
functionality also enables you to scan to other applications’ "Inboxes".

! Scan to PC Desktop™—Scan a document and have the file automatically 
retrieved by PaperPort on the user’s desktop (requires supplemental Scan to PC 
Desktop™ kit).

! Scan to E-Mail—Scan a document and E-Mail it directly to any individuals 
whose names are included in the template’s E-Mail distribution list.

! Scan to Fax—Scan a document and fax it directly to any individuals whose 
names are included in the template’s fax distribution list.

! Scan to Microsoft Exchange Folders—Scan a document and send the electronic 
version directly to a specific Microsoft Exchange Public Folder.
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The installation process varies slightly based on your scanning needs. The following 
table outlines which types of software need to be installed to support each type of 
scanning.

If you want 
to enable...

You need to install.....

Admin

Workstation†
Network

Server†
Distribution

Server†
User 

Workstation

Scan to File •CentreWare 
(CW) Network 
Scanning

•Scan Server 

software1
•CW Network 
Scanning 

(optional)2

•TextBridge OCR 

(optional)2

•CW Network 

Scanning (optional)3 
•TextBridge 

OCR (optional)4 

Scan to PC 
Desktop™

•CW Network 
Scanning

•Scan Server 

software1 

•PaperPort
•TextBridge OCR 
(optional)

•CW Network 

Scanning (optional)3

Scan to E-Mail 
and Distribution

•CW Network 
Scanning

•Scan Server 

software1 

•CW Network 
Scanning

•TextBridge OCR

•E-Mail Client5

•CW Network 

Scanning (optional)3 

•E-Mail Client5

Scan to Fax •CW Network 
Scanning

•Scan Server 

software1 

•CW Network 

Scanning (optional)3 

Scan to Microsoft 
Exchange Folders

•CW Network 
Scanning

•Scan Server 

software1 

•Microsoft 
Outlook Client

•CW Network 
Scanning 

•TextBridge OCR 

(optional)2

•CW Network 

Scanning (optional)3 
•Microsoft Outlook 
Client

Table 2-2:  Software Required to Support Varied Scanning Functionality
†In some network environments, the Admin Workstation, the scan server, and the distribution server can be 

the same machine.
1Installed with CentreWare Add Network Scanner Wizard.
2CW Network Scanning and/or TextBridge OCR installed on Distribution Server only if users desire the 

ability to automatically OCR documents.
3CW Network Scanning required only if users need the ability to create and edit distribution templates. 
4TextBridge only required if users desire the ability to OCR documents after they are scanned. 
5Not distributed with CentreWare software.
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Determining Your Optimal Network Configuration
When you install Network Scanning Services, you create a configuration similar to 
the one shown in Figure 2-1. However, because of the flexibility provided in the 
scanning software, in some network environments you can choose a physical server 
to host the scan server, distribution server, and Administrative software. Or you can 
choose to utilize two or three separate machines. Review the guidelines and 
considerations in the following sections to help determine which configuration might 
work best for your network environment.

Figure 2-1:  Network Scanning Distribution Services
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User PC

Set up scanning software 
(CW_SCAN directory) on 
scan server Scan to File

Scan to PC 
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access scan server

Document 
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Scanner
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NetWare Networks

Because administrative tasks are performed remotely, you will need a workstation to 
perform administrative tasks and a network server. The administrative workstation 
can also be used as the distribution server for processing scan jobs. This machine can 
be your regular workstation; however, because the TextBridge application opens each 
time a file is converted to text, you may want to designate a separate machine. 

If you use a Windows NT workstation, it must be using a NetWare network client 
such as Novell’s Internetworking Client for NetWare.

In NetWare environments, the scan server software is installed on the NetWare server. 

How Will You Manage Network Security?

The Add Network Scanner Wizard works in conjunction with NetWare operating 
systems to grant and verify user access to network scanning. Therefore, user access 
rights are automatically assigned during the scanning installation.
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Updating from a Previous Version
If you are currently using Release 3.2 or 4.1 of the Network Scanning Services 
software, follow the instructions below to update your software to the 5.20 release.

To update release version 3.2 or 4.1 software versions to the 5.20 
release: 

1 Uninstall the previous version of the network scanning software from your 
administrative workstation.

2 Assuming you have already created the required network accounts for the 
Document Centre, follow the instructions for installing the administrator’s 
software on page 2-15. 

3 Open the Xerox Network Scanners Window. Do one of the following based on 
the behavior you observe.

! If the CentreWare software is able to automatically detect your configured 
Document Centre, the Document Centre will appear in the list of scanners. 
Double-click the scanner icon. You will be prompted to upgrade your 
software.

- OR -

! If the CentreWare software does not automatically detect your scanner, use 
the Add Network Scanner Wizard to identify the configured Document 
Centre. 

Follow the steps in the Wizard, choosing the server location where network 
scanning is currently installed for the scan server installation directory. 

A message will appear explaining that the scanning software will be 
upgraded and no data will be lost.

Finish the steps in the Add Network Scanner Wizard. The server update is 
complete.
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4 Uninstall the previous version of the network scanning software at each user’s 
workstation. Install the Release 5.20 software and reboot the workstation. 
Network scanners will be detected automatically. 

5 Follow the instructions for Setting Up Distribution Services on page 4-5 if you 
wish to enable Scan to E-Mail processing.

NOTE: Do not run different release versions of network scanning 
software at the same time. Release 4.1 distribution templates will work 
automatically with the CentreWare 5.20 release, but they will be modified 
to run with 5.x series software only. Templates created with different 
software versions are not interchangeable. 
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Installation Overview
The following diagram illustrates an overview of the Network Scanning Services 
installation process. 

Part 2: Install Administrator’s Software

Part 3: Run the Add Network Scanner Wizard

Part 4: Test the Document Centre
Configuration

Part 1: Create Network User Account
for the Scanner 

Part 5: Install Network Scanning 
on User’s Workstations
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Installation Worksheet
The following table contains information you will need or will determine during the 
Network Scanning Services installation. You may find it helpful to copy this page and 
use it to record data as you proceed through the installation. 

Required 
Information

Record Your Network Data Here

Document Centre Scanner User Name 

Document Centre Scanner Password

E-Mail Account User Name for Scanner
(if enabling Scan to E-Mail)

Scan Server Name/Computer Name

Server Volume/Directory

NDS Context (if applicable)

NDS Tree (if applicable)

Table 2-3:  Network Scanning Services Installation Worksheet
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Installing Network Scanning Services

Part 1: Create a Network User Account for the Scanner 
The Document Centre Scanner requires Read/Filescan access to the scan Template 
Pool and the user’s document folders on the scan server. 

1 Use your network administrative software to create a network user account and 
password (if desired) for the Document Centre scanner. The account must 
contain the following (or equivalent) settings:

! User Cannot Change Password

! Password Never Expires

2 Record the Scanner user name and password on your installation worksheet. You 
will use this information when you run the Add Network Scanner Wizard. 
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Part 2: Install Administrator’s Software
The specific location in which you choose to install the scanning administrative 
software is dependent on your overall network scanning configuration. Several 
configuration considerations and suggestions are included in Determining Your 
Optimal Network Configuration on page 2-8. Be sure you have reviewed this material 
before you continue.

1 Insert the Network Scanning Services CD into the appropriate drive at the 
Administrative workstation. The AutoPlay program displays the available 
selections. 

If AutoPlay is not enabled on your workstation, locate and double-click the 
Setup.exe file at the CD root.

2 Select a language.

3 Click Network Scanning Services and Install Network Scanning Services to 
start the Setup program.

4 Click Next on the Welcome screen.

5 Select Yes to accept the terms in the Software License Agreement screen. This 
screen appears only during the first CentreWare installation.

6 Enter your name and company on the Registration screen. Click Next.

If you currently have no CentreWare software installed on your machine, 
continue with Step 7.

If the following message appears, click OK and skip to Step 9:

A previous installation of CentreWare has been detected. New Services will be 
added to this directory to enable optimum performance. 
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7 Click Next on the Choose Destination Location dialog to accept the default 
installation directory. Installing to the default directory is recommended.

8 Click Next on the Select Program Folder dialog to add the scanning software to 
the Xerox CentreWare program folder. 

9 Click Next on the Start Copying Files dialog to copy the scanning software to the 
hard drive. 

10 Click Yes on the Modify Startup Folder dialog to add a desktop scanning icon to 
the Windows taskbar. This icon enables you to start Scanning Services directly 
from the taskbar.

11 On the Setup Complete dialog, do one of the following: 

! If prompted to reboot, select Yes, I want to restart my computer now. 
Click Finish to complete the installation. 

- OR -

! If you are not prompted to reboot, click Finish. Click Exit to close the 
AutoPlay program.

The scanning software searches your network and automatically detects any scanners 
that are accessible from the workstation. The search may take several minutes on 
large networks. The scanning desktop icon also appears in the taskbar.

NOTE: The software prompts you to reboot only if system files require 
updating. Typically this occurs if you have no other current CentreWare 
software installed on the workstation. 
Installing Network Scanning Services on NetWare Networks



Part 3: Run the Add Network Scanner Wizard
The Add Network Scanner Wizard enables network administrators to install the 
scanning software on the scan server, create document folders, grant user access to 
network scanning, and enable the Document Centre scanner to communicate with the 
scan server. 

1 Start the Add Network Scanner Wizard. 

At the machine on which you installed the Administrative software, select:
Start > Programs > Xerox CentreWare > Add Network Scanner. 

The Add Network Scanner wizard opens.

NOTE: If you are installing Network Scanning Services on an NDS server, your 
workstation must be configured as an NDS client. Otherwise, you cannot browse 
the NDS tree.

Figure 2-2:  Add Network Scanner Wizard
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2 Choose an installation option.

The first screen of the Add Network Scanner Wizard gives you three different 
options:

! Enable a new Document Centre Scanner—enables you to install the 
scanning software on the scan server and configure a Document Centre for 
network scanning (for Administrator use).

! Identify an existing configured Document Centre—enables you to search the 
network for a specific Document Centre that has already been configured for 
network scanning and list that machine in the Xerox Network Scanners 
folder on the PC (for Administrator or users).

! Automatically discover all Document Centre Scanners—enables you to 
search the network for all Document Centres configured for network 
scanning and list those machines in the Xerox Network Scanners folder on 
the PC (for Administrator or users).

For a first-time installation, choose Enable a new Document Centre Scanner 
and click Next.
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3 Choose a method to detect the Document Centre you are configuring for 
scanning.

! To browse the network using NetWare, select I want to browse to find a 
device over and select NetWare from the drop-down box. 

! If you know the machine’s IP Address, TCP/IP Hostname, or IPX Address, 
you can directly access the Document Centre. Select the appropriate option 
and type the machine address or hostname.

Click Next. The Wizard searches the network. A list of available Document 
Centres appears.

Figure 2-3:  Choose A Detection Method

If a particular 
capability is not 
available in your 
network environment, 
the option will not 
appear in the dialog. 

Use the arrow key to 
move to the next 
segment when the 
address contains fewer 
than 3 digits in a 
segment.
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4 Select a Document Centre to configure.

Select the Document Centre you wish to configure from the Devices Found list 
and click Next. 

Figure 2-4:  Result of Network Search for Document Centres

NOTE: CentreWare supports two versions of the Document Centre 230 ST—the 
original Power PC-based version, and the upgraded Intel version. The Add 
Network Scanner Wizard currently lists both versions as "Document Centre 230 
ST" in the Show Devices list box. Therefore, you may need to try the second 
selection if your first 230 ST selection does not display the correct Document 
Centre model. 

Show Devices 
enables you to 
limit the number of 
Document 
Centres displayed 
in the list. 
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5 Enter the Document Centre machine password.

Type the appropriate password to access the Document Centre, and click OK.

Figure 2-5:  Document Centre Password dialog

NOTE: Consult your Document Centre Administrative documentation if 
you don’t know your machine password.
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6 Select your server operating system and browse to the scan server 
installation directory.

Select the operating system of the server you are using for Network Scanning 
Services and type the network path to the directory in which you are installing 
the scan server software. Click Browse if you wish to search your network and 
locate a specific directory or create a new directory folder.

In the example below, the scan server software (\CW_SCAN) will be installed in 
the \elukas directory on a NetWare Bindery server.

Click Next. The Document Centre Login dialog appears.

Figure 2-6:  Select the Server Operating System

The Location 
display illustrates 
the proper format 
you should use 
when typing the 
installation 
location. The text 
changes based 
on the Server 
Operating 
System selected. 

Can also be used 
for NetWare 5.x - 
NDS 
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7 Enter the Document Centre network user name and password you created 
in Part 1. (See page 2-14.)

During this step, a default repository (document folder) is automatically created 
within the \CW_SCAN directory. The default repository is the location where 
documents whose distribution templates don’t specify a destination are stored. 
All enabled scan users are granted Read/Write access to the default repository.

Click Next.

Figure 2-7:  Document Centre Network Login

NOTE: The Advanced button enables you to modify default and alternate 
repository settings. It is not necessary to modify these settings during the 
initial installation.

If you wish to change repository settings at a later time, you can access 
this information from the Scanner > Properties menu. For more 
information, refer to Managing Scanner Properties on page 6-2.
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8 Create scan user accounts. 

The following process enables you to grant scanning access to network users.

a) Click New > User to begin adding scan users. The Add User dialog appears.

Figure 2-8:  Add Scan Users and Groups

Refer to If you are not prompted to reboot, click Finish. on page 2-27 for an explanation of 
when to use this selection.
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b) Select the names of all network users who should be given access to network 
scanning. (Refer to Help for tips on selecting multiple names at once.) Click 
OK. 

c) Click Next on the Scan Folders dialog.

Figure 2-9:  Add Users Dialog

NOTE: Do not add the Document Centre account as a user on this 
screen. Access rights for the scanner are set up separately.

You may also create scan groups which enable multiple users to scan to a 
common document folder. Click Help or see Managing Scan Users on 
page 5-2 for more information on adding scan users and groups.
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9 Complete scan server installation and configuration. 

Click Finish on the final Wizard dialog to configure your network scanner. 
Scanning data is transferred to the Document Centre. Document folders and 
default templates are created on the scan server for each scan user or group. 

Part 4: Test the Document Centre Configuration
Go to the Document Centre scanner, update the list of scan templates, and scan a 
sample document to confirm that your scanning installation worked correctly. 

NOTE: See Chapter 9, Scanning A Document, for more information on updating 
scan templates and scanning documents.

If you are unable to scan, see Chapter 12, Problem Solving.
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Part 5: Install Network Scanning Services on User’s 
Workstations

1 Insert the Network Scanning Services CD into the appropriate drive. The 
AutoPlay program displays the available CD selections. 

If AutoPlay is not enabled on your workstation, locate and double-click the 
Setup.exe file at the CD root.

2 Select a language.

3 Click Network Scanning Services and Install Network Scanning Services to 
start the Setup program.

4 Follow the instructions in the Setup program. 

For step-by-step instructions, follow the steps for installing Network Scanning 
Services on the Administrator’s workstation on page 2-15.

5 Click Yes on the Modify Startup Folder screen to add a desktop scanning icon to 
the Windows taskbar. Adding this icon enables you to start Scanning Services 
directly from the taskbar.

6 On the Setup Complete dialog, do one of the following: 

! If prompted to reboot, select Yes, I want to restart my computer now. 
Click Finish to complete the installation. 

- OR -

! If you are not prompted to reboot, click Finish. 

NOTE: The software prompts you to reboot only if system files require 
updating. Typically this occurs if you have no other current CentreWare 
software installed on the workstation. 
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3

Installing Network Scanning Services
on Non-NetWare Networks

This chapter contains system requirements, information to help you plan your 
installation, an installation overview, and detailed procedures for installing the 
Network Scanning Services software on Windows NT and OS/2 Warp servers as well 
as SUN OS, HP-UX, or AIX systems. 

A complete installation involves installing and running administrative software to set 
up the scan server, enabling the Document Centre to communicate with network 
scanning software, and installing applications on the user workstations. 

To enable Scanning to E-Mail or distribution, you must also set up a distribution 
server. See Chapter 4, Enabling Scan to E-Mail and Distribution, for more 
information on installing distribution services.
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Key Terms
Understanding the following terms will better enable you to perform the Network 
Scanning Services installation:

FTP Installations. A term used throughout this book to designate scanning 
installations to an FTP server. Installations to Windows NT FAT partitions, OS/2 
Warp servers, and SUN OS, HP-UX, or AIX systems are all considered FTP 
Installations.

Distribution Server.  A Windows 95/98 or Windows NT 4.0 client, Windows 2000 
Professional or a Windows NT 4.0 or Windows 2000 server set up to host automated 
document processing. The type of processing that takes place is based on the services 
specified in a distribution template. The distribution server manages automated Scan 
to E-Mail, OCR processing, and other distribution services. 

Distribution Template.  A distribution template is a component of the Network 
Scanning Services software which contains specific instructions on how to process or 
store a network scan job. The information in the template defines various scan, OCR, 
fax, and E-Mail settings that may be required to complete the scan job. Each user is 
assigned a default template when the Administrator sets up access to network 
scanning. 

Document Folder.  A document folder is a filing directory on a network server in 
which scanned files are stored. 

Scan Server. The network server on which the Network Scanning Services software 
(\CW_SCAN directory) is installed. It typically hosts the scan template pool, user 
document folders, a default scanning repository, and group repositories (if groups are 
supported by the network configuration). 

Template Pool. A directory location on a network file server (the scan server) in 
which scan templates are stored. New templates created with Network Scanning 
Services are automatically stored in the template pool. 
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Installation Requirements

Document Centre Configuration Requirements

! The Document Centre is connected, configured, and functioning as a network 
printer.

! The scanning option kit is installed on the Document Centre. 

Workstation Configuration Requirements

Network Scanning Services software is available for 32-bit environments. The 
minimum recommended workstation configuration is:

Microsoft Windows 95 and Windows 98 Workstations

! 486DX, 66 MHz or higher processor.

! At least 10 MB of available hard-disk space.

! 16 MB of memory or higher.

! CD-ROM drive.

! VGA (or higher-resolution) display adapter.

Microsoft Windows NT 4.0 and Windows 2000 Workstations

! Intel-based systems—Pentium or faster; RISC-based systems—workstation with 
Alpha AXP, MIPS R4X00, or PowerPC processor.

! At least 10 MB of available hard-disk space.

! 32 MB of memory (minimum), 64 MB (recommended).

! CD-ROM drive.

! VGA (or higher-resolution) display adapter.

NOTE: If you are using Windows 2000, check the ReadMe files or the 
CentreWare website for the latest information on compatibility or support.
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Network Configuration Requirements

Scan Server Requirements

The configuration requirements for the scan server include: 

! any of the following servers or workstations:

! Windows NT 3.51, 4.0, or Windows 2000 server

! Windows 95, Windows 98, or Windows 2000 Professional, with installed 
FTP server

! SunOS 2.x, HP-UX 11.0, or AIX 4.0, with installed FTP server

! OS/2 Warp Server 4.0, with installed FTP server

! a minimum of 2.5 MB available disk space, plus sufficient space to store 
TIFF/PDF files. The minimum requirements will vary based on the number of 
scan users. 

! a CD-ROM drive if the installation is performed directly at the server.

Connectivity Requirements

During scan processing, the Document Centre must make a connection and transmit 
document images to folders on a file server. On non-NetWare networks, Network 
Scanning Services uses File Transfer Protocol (FTP) filing via IP over Ethernet or 
Token Ring.
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SNMP Community Names

If you are using SNMP Community Names other than the default GET/SET names 
Public and Private for device management, the CentreWare software will not be able 
to automatically discover and maintain communication with the Document Centre. To 
re-establish communication, you must run the CentreWare Device Discovery Wizard 
(found on the Network Admin Services CD) before you install Network Scanning 
Services. The Device Discovery Wizard enables you to discover the Document 
Centre on the network and creates a discovery update file (.mts) containing the device 
address/community name associations for each Document Centre. 

The discovery update file must be distributed to and executed by all scanning users 
before they can view and interact with any Document Centres whose Community 
Names have been changed from their default values. 

NOTE: Users must have Network Scanning Services installed on their 
workstations before they can perform the device discovery update. Then they can 
simply double-click the .mts file on the workstation to execute the file update. 
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Security Requirements

Network Administrators

Network Administrators must possess the following network rights to configure the 
scan server with the Add Network Scanner Wizard:

Scan Users

Scan users require network access to the \CW_SCAN directory on the scan server. 
Refer to How Will You Manage Network Security? on page 3-12 and the Summary of 
Access Rights on page A-4 for more information on scanning access rights.

Network Server Type Required Access Rights

Windows NT Administrator/Domain Administrator rights in the domain in 
which network scanning will be installed.

Account Operators can also perform installations; however, the 
Administrator must first modify account policies to enable the 
Account Operator to complete the installation.

All Others A minimum of Read/Write access to the directory in which 
network scanning will be installed.

Table 3-1:  Summary of Required Rights
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Document Centre Scanner

The Document Centre scanner requires a valid network login name and password to 
gain access to the scanning directory structure on the scan server. You must create this 
account prior to installation using your network administration tools.

The method you will use to assign access rights varies based on your network type:

! Windows NTFS Partitions—Necessary rights will be granted to the Document 
Centre account during setup with the Add Network Scanner Wizard. 

! For Windows NT FAT partitions and all Other Network Types—The account 
established for the Document Centre scanner requires Read/Execute access to the 
template pool on the scan server and Read/Write access to file scan jobs to 
various document folders.
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Planning the Installation
Before you begin the Network Scanning Services installation, you should take a few 
minutes to consider how your organization will use the scanning software and 
determine the optimal configuration for your network. Some basic issues to consider 
are outlined below. 

What Scanning Functionality Do You Need?
Network Scanning Services gives you the ability to install and configure different 
scanning capabilities based on your organization’s needs. You can perform four basic 
scanning functions:

! Scan to File (Document Folder)—Scan a document and store the electronic 
version in a specific document folder (directory) on a network file server. This 
functionality also enables you to scan to other applications’ "Inboxes".

! Scan to PC Desktop™—Scan a document and have the file automatically 
retrieved by PaperPort on the user’s desktop (requires supplemental Scan to PC 
Desktop™ kit).

! Scan to E-Mail—Scan a document and E-Mail it directly to any individuals 
whose names are included in the template’s E-Mail distribution list.

! Scan to Fax—Scan a document and fax it directly to any individuals whose 
names are included in the template’s fax distribution list.

! Scan to Microsoft Exchange Folders—Scan a document and send the electronic 
version directly to a specific Microsoft Exchange Public Folder.
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The installation process varies slightly based on your scanning needs. The following 
table outlines which types of software need to be installed to support each type of 
scanning.

If you want 
to enable...

You need to install.....

Admin

Workstation†
Network

Server†
Distribution

Server†
User 

Workstation

Scan to File •CentreWare 
(CW) Network 
Scanning

•Scan Server 

software1
•CW Network 

Scanning2 

•TextBridge OCR 

(optional)2

•CW Network 

Scanning (optional)3 
•TextBridge 

OCR (optional)4 

Scan to PC 
Desktop™

•CW Network 
Scanning

•Scan Server 

software1 

•PaperPort
•TextBridge OCR 
(optional)

•CW Network 

Scanning (optional)3

Scan to E-Mail 
and Distribution

•CW Network 
Scanning

•Scan Server 

software1 

•CW Network 
Scanning

•TextBridge OCR

•E-Mail Client5

•CW Network 

Scanning (optional)3 

•E-Mail Client5

Scan to Fax •CW Network 
Scanning

•Scan Server 

software1 

•CW Network 

Scanning (optional)3 

Scan to Microsoft 
Exchange Folders

•CW Network 
Scanning

•Scan Server 

software1 

•Microsoft 
Outlook Client

•CW Network 
Scanning 

•TextBridge OCR 

(optional)2

•CW Network 

Scanning (optional)3 

Table 3-2:  Software Required to Support Varied Scanning Functionality
†In some network environments, the Admin Workstation, the scan server, and the distribution server can be 

the same machine.
1Installed with CentreWare Add Network Scanner Wizard.
2CW Network Scanning and/or TextBridge OCR installed on Distribution Server only if users desire the 

ability to automatically OCR documents.
3CW Network Scanning required only if users need the ability to create and edit distribution templates. 
4TextBridge only required if users desire the ability to OCR documents after they are scanned. 
5 Not distributed with CentreWare software.
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Determining Your Optimal Network Configuration
When you install Network Scanning Services, you create a configuration similar to 
the one shown in Figure 3-1. However, because of the flexibility provided in the 
scanning software, in some network environments you can choose a single server to 
function as the scan server, distribution server, and Administrative workstation. Or 
you can choose to utilize two or three separate machines. Review the guidelines and 
considerations in the following sections to help determine which configuration might 
work best for your network environment.

Figure 3-1:  Network Scanning Distribution Services

Scan Job

Scan Server
Template Pool
Document Folders

Admin Workstation

User PC

Set up scanning software 
(CW_SCAN directory) on 
scan server Scan to File

Scan to PaperPort 
Desktop
(optional software)

Enable DC scanner to 
access scan server

Document 
Centre

Scanner
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Windows NT Networks

The use of a Windows NT workstation or server enables the same PC or server to 
function as the Admin workstation, the scan server, and as the distribution server for 
processing scan jobs. 

Other Networks (FTP Installations)

The network configuration and number of machines required will vary based on your 
network type. You must be using one of the server operating systems outlined in the 
Scan Server Requirements on page 3-4. You will need a network file-access utility 
(such as NFS) to connect to a specific drive letter, shared directory, or location of the 
scan server. 

You must use Internet Explorer 3.0.1 (or higher). The CentreWare software uses some 
files distributed with Internet Explorer. If you are not running I.E. version 3.0.1 (or 
higher) the scanning software cannot automatically determine the path to the scan 
server, and users may need to enter the path manually. 
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How Will You Manage Network Security?

The Add Network Scanner Wizard works in conjunction with Microsoft Windows 
NTFS operating systems to grant and verify user access to network scanning. 
Therefore, in this network environment, user access rights are automatically assigned 
during the scanning installation.

For installations to Windows NT FAT partitions, OS/2 Warp servers, SUN OS, 
HP-UX, or AIX systems, you must control and manage access to scanning through 
your network server operating system. You may wish to create scanning access rights 
that mimic the rights assigned during installation for NetWare or Windows NTFS 
networks. Refer to the Summary of Access Rights on page A-4 for more information 
on scanning access rights.
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Updating from a Previous Version
If you are currently using Release 3.2 or 4.1 of the Network Scanning Services 
software, follow the instructions below to update your software to the 5.20 release.

To update earlier versions of Network Scanning Services to the 5.20 
release:

1 Uninstall the previous version of the network scanning software from your 
administrative workstation.

2 Assuming you have already created the required network accounts for the 
Document Centre, follow the instructions for installing the administrator’s 
software on page 3-22. 

3 Open the Xerox Network Scanners Window. Do one of the following based on 
the behavior you observe.

! If the CentreWare software is able to automatically detect your configured 
Document Centre, the Document Centre will appear in the list of scanners. 
Double-click the scanner icon. You will be prompted to upgrade your 
software.

- OR -

! If the CentreWare software does not automatically detect your scanner, use 
the Add Network Scanner Wizard to identify the configured Document 
Centre. 

Follow the steps in the Wizard, choosing the server location where network 
scanning is currently installed for the scan server installation directory. 

A message will appear explaining that the scanning software will be 
upgraded and no data will be lost.

Finish the steps in the Add Network Scanner Wizard. The server update is 
complete.
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4 Uninstall the previous version of the network scanning software at each user’s 
workstation. Install the Release 5.20 software and reboot the workstation. 
Network scanners will be detected automatically. 

5 Follow the instructions for Setting Up Distribution Services on page 4-5 if you 
wish to enable Scan to E-Mail processing.

NOTE: Do not run different release versions of network scanning 
software at the same time. Release 4.1 distribution templates will work 
automatically with the CentreWare 5.20 release, but they will be modified 
to run with 5.x series software only. Templates created with different 
software versions are not interchangeable. 
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Installation Overview
The following diagram illustrates an overview of the Network Scanning Services 
installation process. 

Part 3: Install Administrator’s Software

Part 4: Run the Add Network Scanner Wizard

Part 6: Test the Document Centre
Configuration

Part 1: Create Network User Account
for the Scanner 

Part 2: Set Up Installation Directory and Enable FTP

Part 5: Test the FTP Connection

Part 7: Install Network Scanning 
on User’s Workstations
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Installation Worksheet
The following table contains information you will need or will determine during the 
Network Scanning Services installation. You may find it helpful to copy this page and 
use it to record data as you proceed through the installation. 

Required 
Information

Record Your Network Data Here

Document Centre Scanner User Name 

Document Centre Scanner Password

E-Mail Account User Name for Scanner
(if enabling Scan to E-Mail)

Scan Server Name/Computer Name

Server Volume/Directory

Shared Directory Name and Scanning 
Subdirectory Name (if applicable)

Table 3-3:  Network Scanning Services Installation Worksheet
Installing Network Scanning Services on Non-NetWare Networks



Installing Network Scanning Services

Part 1: Create a Network User Account for the Scanner 
The Document Centre Scanner requires Read/Execute access to the scan Template 
Pool and the user’s document folders on the scan server. 

1 Use your network administrative software to create a network user account and 
password (if desired) for the Document Centre scanner. The account must 
contain the following (or equivalent) settings:

! User Cannot Change Password

! Password Never Expires

! Rights to Log On Locally assigned to the EVERYONE group. (Windows 
NT)

2 Record the Scanner user name and password on your installation worksheet. You 
will use this information when you run the Add Network Scanner Wizard. 

Figure 3-2:  Example of Required Rights (from Windows NT User Manager)
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Part 2: Set Up Installation Directory and Enable FTP 
Create a directory on the scan server in which the scanning software can be installed, 
and make that directory accessible to any machine that supports the scanning 
functionality. You can do this in either of two ways:

! enabling installation in the FTPROOT (home) directory

- OR -

! setting up a virtual directory

Each option is outlined in the following sections.

NOTE: The following sections use terms and examples specific to Microsoft’s 
Internet Information Server. Terminology and procedures may vary with other FTP 
tools or in other network environments.
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Enabling Installation in the FTPROOT Directory

If you don’t need to restrict access to your default FTPROOT (home) directory, you 
can install Network Scanning Services directly within FTPROOT.

The following diagram illustrates a scanning installation in the FTPROOT directory.

1 Share the FTPROOT (home) directory, accepting the default rights. 

2 Create a separate subdirectory within FTPROOT for each scanning installation. 
Creating separate installation subdirectories enables you to install, manage, and 
uninstall multiple scan servers without overwriting or deleting other installations.

3 Read Assigning Shared Directory Permissions on page 3-21 and continue with 
Part 3: Install Administrator’s Software on page 3-22.

Figure 3-3:  Network Scanning Installed in FTPROOT 

C:\\InetPub

Server_A
Scan Server

\\<server>\<sharename>\<optional_dir>\cw_scan
\\Server_A\ftproot\scanner1\cw_scan

cw_scan*

ftproot (shared)

*created during installation with 
Add Network Scanner Wizard

scanner1 (optional)
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Setting Up a Virtual Directory

If you need to restrict access to the default FTPROOT directory, or if you are 
installing network scanning on a separate drive, you can create a virtual path to an 
installation directory (virtual directory) in which to install the scan server software. 
The virtual directory may reside inside or outside the default FTP home directory 
structure and is accessible from the FTP service. The virtual directory is identified by 
an alias. The use of an alias enables remote access to the directory. The following 
diagram illustrates a scanning installation using a virtual directory.

1 Create a Shared Directory on the scan server, and accept the default access rights.

2 In the Shared Directory, create a separate subdirectory for each scanning 
installation. This is the directory into which the network scanning software can 
later be installed. 

Figure 3-4:  Required Virtual Directory Structure 

NOTE: Creating this subdirectory is essential to ensure that the proper 
FTP path is written to the Document Centre scanner during installation. 
Otherwise the Document Centre will not be able to access the network 
scanning software.

\\<server>\<sharename>\<virtual directory name>\cw_scan
\\Server_A\scanning\dc265\cw_scan

dc265 (Virtual Directory/Alias Name)

cw_scan*

e:\

scanning (Shared)

virtual link to 
dc265 directory on 
drive e:\

C:\\InetPub\ftproot

Server_A
Scan Server

*created during installation with Add Network Scanner Wizard
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3 Use your FTP server software to establish the virtual directory and assign an 
alias. Ensure that Read and Write access to the directory is enabled.

4 Record the Shared Directory and virtual directory names on your installation 
worksheet. 

In Part 4 of the scanning installation, the Add Network Scanner Wizard requires 
you to enter the location in which the scanning software should be installed. The 
network location and path you supply on that dialog (see page 3-30) must 
correspond to the Shared and Virtual directories you established on the scan 
server. 

Assigning Shared Directory Permissions

User access rights are limited by the permissions of the shared directory. By default, 
when you created a share in Windows NT, the EVERYONE group is granted full 
access to the share. If you have no need to restrict user access to network scanning, 
you will not need to modify the default access rights. 

If you wish to restrict access to network scanning, you should first complete the 
Network Scanning Services installation. Once the installation is completed, ensure 
that the ENABLEDSCANUSERS group (created during installation) has Change 
access at the Share level. (See Windows NT Networks on page A-5 for additional 
information.)

NOTE: The virtual directory must be established one directory below the 
Shared Directory, and you must use the name of the virtual directory as 
the alias name.

Figure 3-5:  Add Network Scanner Wizard Server Operating System dialog

To maintain the required directory 
relationships, the first directory 
under "Path" must be the virtual 
directory. 
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Part 3: Install Administrator’s Software
The specific location in which you choose to install the scanning administrative 
software is dependent on your overall network scanning configuration. Several 
configuration considerations and suggestions are included in Determining Your 
Optimal Network Configuration on page 3-10. Be sure you have reviewed this 
material before you continue.

1 Insert the Network Scanning Services CD into the appropriate drive. The 
AutoPlay program displays the available selections. 

If AutoPlay is not enabled on your workstation, locate and double-click the 
Setup.exe file at the CD root.

2 Select a language.

3 Click Network Scanning Services and Install Network Scanning Services to 
start the Setup program.

4 Click Next on the Welcome screen.

5 Select Yes to accept the terms in the Software License Agreement screen. This 
screen appears only during the first CentreWare installation.

6 Enter your name and company on the Registration screen. Click Next.

If you currently have no CentreWare software installed on your machine, 
continue with Step 7.

If the following message appears, click OK and skip to Step 9:

A previous installation of CentreWare has been detected. New Services will be 
added to this directory to enable optimum performance. 

NOTE: If you are installing Scanning Services on a Windows NTFS file partition, 
you must install the administrative software directly onto the server or on a 
Windows NT workstation. Otherwise, when you run the Add Network Scanner 
Wizard (in Part 4), you will not be able to use the Domain security features built into 
the network scanning software.
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7 Click Next on the Choose Destination Location dialog to accept the default 
installation directory. Installing to the default directory is recommended.

8 Click Next on the Select Program Folder dialog to add the scanning software to 
the Xerox CentreWare program folder. 

9 Click Next on the Start Copying Files dialog to copy the scanning software to the 
hard drive. 

10 Click Yes on the Modify Startup Folder dialog to add a desktop scanning icon to 
the Windows taskbar. This icon enables you to start Scanning Services directly 
from the taskbar.

11 On the Setup Complete dialog, do one of the following: 

! If prompted to reboot, select Yes, I want to restart my computer now. 
Click Finish to complete the installation. 

- OR -

! If you are not prompted to reboot, click Finish. Click Exit to close the 
AutoPlay program.

The scanning software searches your network and automatically detects any scanners 
that are accessible from the workstation. The search may take several minutes on 
large networks. The scanning desktop icon also appears in the taskbar.

NOTE: The software prompts you to reboot only if system files require 
updating. Typically this occurs if you have no other current CentreWare 
software installed on the workstation. 
Installing Network Scanning Services 3-23



3-24
Part 4: Run the Add Network Scanner Wizard
The Add Network Scanner Wizard enables network administrators to install the 
scanning software on the scan server, create document folders, grant user access to 
network scanning, and enable the Document Centre scanner to communicate with the 
scan server.

1 Start the Add Network Scanner Wizard. 

At the machine on which you installed the Administrative software, select:
Start > Programs > Xerox CentreWare > Add Network Scanner. 

The Add Network Scanner wizard opens.

Figure 3-6:  Add Network Scanner Wizard
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2 Choose an installation option.

The first screen of the Add Network Scanner Wizard gives you three different 
options:

! Enable a new Document Centre Scanner—enables you to install the 
scanning software on the scan server and configure a Document Centre for 
network scanning (for Administrator use).

! Identify an existing configured Document Centre—enables you to search the 
network for a specific Document Centre that has already been configured for 
network scanning and list that machine in the Xerox Network Scanners 
folder on the PC (for Administrator or users).

! Automatically discover all Document Centre Scanners—enables you to 
search the network for all Document Centres configured for network 
scanning and list those machines in the Xerox Network Scanners folder on 
the PC (for Administrator or users).

For a first-time installation, choose Enable a new Document Centre Scanner 
and click Next. 
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3 Choose a method to detect the Document Centre you are configuring for 
scanning.

! To browse the network using TCP/IP or Microsoft Networking, select I want 
to browse to find a device over and select the network type from the drop-
down box. 

! If you know the machine’s IP Address or TCP/IP Hostname, you can directly 
access the Document Centre. Select the appropriate option and type the 
machine address or hostname.

Click Next.

Figure 3-7:  Choose A Detection Method

If a particular 
capability is not 
available in your 
network environment, 
the option will not 
appear in the dialog. 

Use the arrow key to 
move to the next 
segment when the 
address contains less 
than 3 digits in a 
segment.
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4 Search subnets or workgroups. 

The scanning software automatically searches your local TCP/IP subnet or 
Microsoft workgroup for available Document Centres. You can expand or restrict 
the search by indicating specific subnets or workgroups to search. 

! For TCP/IP: Type a subnet address in the box and click Add to add it to the 
list of subnets to be searched.

! For Microsoft Networks: Scroll through the list of Available Workgroups. 
Select one or more workgroups and click Add to move them to the list of 
workgroups to be searched.

Click Next. The Wizard searches the network. A list of available Document 
Centres appears.

Figure 3-8:  TCP/IP and MSN Search Methods

Microsoft Networking 
workgroup dialog.
If you previously logged into 
an NT domain, your current 
Workgroup name 
automatically appears in the 
Workgroups list.

TCP/IP subnet dialog
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5 Select a Document Centre to configure.

Select the Document Centre you wish to configure from the Devices Found list 
and click Next.

Figure 3-9:  Result of Network Search for Document Centres

Show Devices 
enables you to 
limit the number of 
Document 
Centres displayed 
in the list. 
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6 Enter the Document Centre machine password.

Type the appropriate password to access the Document Centre, and click OK.

Figure 3-10:  Document Centre Password dialog

NOTE: Consult your Document Centre Administrative documentation if 
you don’t know your machine password.
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7 Select your server operating system and browse to the scan server 
installation directory.

Specify the operating system of the server you are using for Network Scanning 
Services and type the network path to the directory in which you are installing 
the scan server software. Click Browse if you wish to search your network and 
locate a specific directory or create a new directory folder.

In the example below, the scan server software (\CW_SCAN) will be installed on 
an FTP server. 

Click Next.

Figure 3-11:  Select the Server Operating System

NOTE: For FTP installations, the network location and path you supply 
must correspond to the Shared and Virtual directories you previously 
created on the scan server. See page 3-18 for additional information.

The Location 
display illustrates 
the proper format 
you should use 
when typing the 
installation 
location. The text 
changes based 
on the Server 
Operating 
System selected. 
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8 Enter the Document Centre network user name and password you created 
in Part 1. (See page 3-17.)

On the Document Centre Login Screen, type the network user name and 
password you created previously for the Document Centre.

During this step, a default repository (document folder) is automatically created 
within the \CW_SCAN directory. The default repository is the location where 
documents whose distribution templates don’t specify a destination are stored. 
All enabled scan users are granted Read/Write access to the default repository.

Click Next.

Figure 3-12:  Document Centre Network Login

NOTE: The Advanced button enables you to modify default and alternate 
repository settings. It is not necessary to modify these settings during the 
initial installation.

If you wish to change repository settings at a later time, you can access 
this information from the Scanner > Properties menu. For more 
information, refer to Managing Scanner Properties on page 6-2.
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9 Create scan user accounts. 

This process enables you to grant scanning access to network users (Windows 
NTFS) and to create user document folders on the scan server (all environments).

Figure 3-13:  Add Scan Users and Groups

Other (FTP) 
Installations 
You must grant 
users specific 
network access 
after scanning is 
installed.

 Windows NT 
(NTFS partitions). 
Scanning access 
rights assigned 
within Wizard. 

Refer to If you are not prompted to reboot, 
click Finish. on page 3-36 for an explanation 
of when to use this selection.
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a) Click New or New > User to begin adding scan users. The Add User dialog 
appears. 

b) Do one of the following:

For Windows NT Files Systems (NTFS): Select the names of all network 
users who should be given access to network scanning. (Refer to Help for 
tips on selecting multiple names at once.) Click OK.

For FTP installations: Individual user names must be added separately. 
Type the network name of a user for whom a document folder should be 
created. Click OK. To add additional names, click New > User again and 
repeat the same process until all users are added. 

No validation is performed on the names you type.

Figure 3-14:  Add User Dialogs

NOTE: Do not add the Document Centre account as a user on this 
screen. Access rights for the scanner are set up separately.

New User Screen for 
Windows NT File Systems 
(NTFS).

New User Screen for FTP 
installations:
Windows NT FAT 
partitions, UNIX, or OS/2.
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A distribution template is created for each scan user. These templates enable 
users to scan documents from the Document Centre to their document 
folders.

c) Click Next on the Scan Folders dialog.

10 Complete scan server installation and configuration. 

Click Finish on the final Wizard dialog to configure your network scanner. 
Scanning data is transferred to the Document Centre. Document folders and 
default templates are created on the scan server for each scan user. 

NOTE: If you are working on a Windows NT network (NTFS partition), 
you may also create scan groups which enable multiple users to scan to a 
common document folder.

Click Help or see Managing Scan Users on page 5-2 for more information 
on adding scan users and groups.
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Part 5: Test the FTP Connection 
Now that you have installed the scanning software on the scan server, you need to test 
the FTP setup created in Part 2: Set Up Installation Directory and Enable FTP. 

To test your FTP setup:

1 From your workstation, open an FTP session and log in to the FTP server using 
the Document Centre’s User Name and Password. 

2 Ensure that you can log in and view the contents of the \CW_SCAN directory.

Part 6: Test the Document Centre Configuration
Go to the Document Centre scanner, update the list of scan templates, and scan a 
sample document to confirm that your scanning installation worked correctly. 

NOTE: If you are unable to scan, re-read Part 2: Set Up Installation Directory 
and Enable FTP on page 3-18. Also refer to Chapter 12, Problem Solving.

NOTE: See Scanning A Document on page 9-1 for more information on updating 
scan templates and scanning documents.

If you are unable to scan, see Chapter 12, Problem Solving.
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Part 7: Install Network Scanning Services on User’s 
Workstations

1 Insert the Network Scanning Services CD into the appropriate drive. The 
AutoPlay program displays the available CD selections. 

If AutoPlay is not enabled on your workstation, locate and double-click the 
Setup.exe file at the CD root.

2 Select a language.

3 Click Network Scanning Services and Install Network Scanning Services to 
start the Setup program.

4 Follow the instructions in the Setup program. 

For step-by-step instructions, follow the steps for installing Network Scanning 
Services on the Administrator’s workstation on page 3-22.

5 Click Yes on the Modify Startup Folder screen to add a desktop scanning icon to 
the Windows taskbar. Adding this icon enables you to start Scanning Services 
directly from the taskbar.

6 On the Finish dialog, do one of the following: 

! If prompted to reboot, select Yes, I want to restart my computer now. 
Click Finish to complete the installation. 

- OR -

! If you are not prompted to reboot, click Finish. 

NOTE: The software prompts you to reboot only if system files require 
updating. Typically this occurs if you have no other current CentreWare 
software installed on the workstation. 
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Enabling Scan to E-Mail and Distribution

CentreWare’s scanning distribution capabilities enable users to scan documents 
directly to E-Mail without further manual processing. To enable Distribution 
Services, a workstation or server must be set up to host automated document 
processing. The distribution server manages E-Mail distribution as well as OCR 
processing.
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The following diagram illustrates CentreWare’s automated distribution capabilities.

Figure 4-1:  Network Scanning Distribution Services
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nabling Scan to E-Mail and Distribution



Distribution Server Requirements

Network Scanning Services offers you the flexibility to establish the distribution 
server on a network PC or server. This machine can be your regular workstation; 
however, because the TextBridge application opens each time a file is converted to 
text, you may want to designate a separate machine.

The distribution server should meet the following minimum requirements: 

! a Windows 95, Windows 98, Windows NT, or Windows 2000 Professional client

! an installed MAPI-32 compliant E-Mail client (see below)

! a CD-ROM drive

To enable OCR, TextBridge must be also installed on the distribution server.

E-Mail Requirements

A MAPI-32 compliant E-Mail system such as Microsoft Exchange, Outlook, cc:Mail 
(version 8+), or MS Internet Mail is required for Scan to E-Mail processing. Outlook 
Express is not MAPI-32 compliant and is not supported. 

The E-Mail client must be installed and running on the distribution server with access 
to an active E-Mail account before Scan to E-Mail processing can occur. The 
scanning software interacts with E-Mail Address Books; therefore, E-Mail clients 
must be installed on user’s workstations before they can create Scan to E-Mail 
Templates. 

The Distribution Server and the E-Mail server can share the same machine, but you 
may be required to reboot the machine after you install the scanning software. 

NOTE: To use an Outlook 2000 client with CentreWare’s Scan to Exchange Public 
Folders functionality, you must install Outlook 2000 using the custom installation 
and select the Collaboration Data Objects optional component. In previous 
versions of the Outlook client, these data objects were installed automatically. In 
the Outlook 2000 software, they are optional.
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Distribution Setup Overview

The following diagram illustrates an overview of the process required to enable 
distribution services. 

Part 4: Install TextBridge Pro 
on the Distribution Server

Part 1: Create a Distribution Server E-Mail Account

Part 3: Grant Distribution Server Network
Account Access to CentreWare Inbox

Part 5: Test the Distribution Functionality

Part 2: Set Up the Distribution Server
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Setting Up Distribution Services
Setting up distribution services with the CentreWare software is a simple task. Once 
you coordinate a few key elements, you are ready to scan. Follow the steps below to 
enable distribution services.

Part 1: Create a Distribution Server E-Mail Account

Create an E-Mail account, or assign an existing account, to be used as the Distribution 
Server account.

Part 2: Enable the Distribution Server

To designate a machine as a Distribution Server:

1 If you have not already done so, install the Network Scanning Services software 
on the Distribution Server machine. Refer to the installation chapter for your 
network environment for further details. 

2 Open the Xerox Network Scanners Window. Select:

Start > Programs > Xerox CentreWare > Xerox Network Scanners.

3 Select a connected Document Centre from the list of available scanners.

4 From the Scanner Menu, choose Properties. The Properties dialog opens.

NOTE: Before you perform these steps, the scan server must have been installed 
on the network, and you must have Administrative rights to the server.
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5 Choose the Distribution tab and select Make this PC the Distribution Server. 

6 Click OK.

Part 3: Grant Distribution Server Network Account Access to 
CentreWare Inbox

The network account used by the distribution server requires access to the 
CentreWare Inbox—a directory on the scan server where scanned documents are held 
for distribution. Granting access to the Inbox gives the distribution server account 
Read/Write permission to the Inbox and to each scan user’s document folder on the 
scan server. 

Figure 4-2:  Setting Up the Distribution Server
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To assign the distribution server access to the CentreWare Inbox: 

Do one of the following:

! Use the same network login account for the distribution server that you assigned 
to the Document Centre. By default, this account has access to the Inbox.

- OR -

! Grant the distribution server network account access to the CentreWare Inbox. 

! Open the Xerox Network Scanners window and select the Document Centre. 

! From the Scanner Menu, choose Manage Users. 

! Add the distribution server network account to the list of enabled scan users. 

! Select the distribution server account in the list of network accounts. Then 
select Grant user access to the CentreWare inbox for this scan server. 

! Click OK.

In the example below swantuck is the distribution server account which has been 
given rights to watch the scan server Inbox. 

Figure 4-3:  Scan folders dialog (Add Network Scanner Wizard or Manage Users)

The selected 
network user 
name 
(swantuck) 
has been 
granted 
access to the 
Inbox 
directory.
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Part 4: Install TextBridge Pro on the Distribution Server

To enable automated Optical Character Recognition for Scan-to-E-Mail or Scan-to-
File (document folder) operations, TextBridge Pro must be installed on the 
distribution server.

Locate the installation CD in the Scan to PC Desktop™ software package distributed 
with Network Scanning Services. Follow the automated installation program to install 
TextBridge Pro. 

Part 5: Test the Distribution Functionality 

Verify that the distribution services are functioning correctly. 

To test distribution functionality:

1 Create a scan to E-Mail template which includes OCR. 

Open the Xerox Network Scanners window and double-click the Document 
Centre name. The Distribution Template window opens. 

Use your own E-Mail address for the destination. 

2 Go to the Document Centre scanner, update the list of scan templates, and scan a 
sample document. 

3 Check your E-Mail to make sure you received the document.

If you are unable to scan, see Chapter 12, Problem Solving.

NOTE: See Creating a Scan-to-E-Mail Template on page 7-12 for 
specific instructions on creating a test template.

NOTE: See Chapter 9, Scanning A Document for more information on 
how to update scan templates and how to scan documents.
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Managing Scan User Access

This chapter contains information which will enable network administrators to 
quickly and easily manage scan user accounts. Managing accounts involves adding, 
deleting, and modifying users’ access to Network Scanning Services. In NetWare and 
Windows NTFS network environments, Administrators can also create scan groups in 
which many users have access to the same document folder. 
5-1



5-2 M
Managing Scan Users
During the initial scanning installation, the Add Network Scanner Wizard allows 
network administrators to add, delete, and edit scan user properties. Once the scan 
server software has been installed, you don’t need to run the Wizard again to modify 
properties; you can simply use the Manage Users option on the Scanner Menu of the 
Xerox Network Scanners (XNS) window. This option enables you go directly to user 
settings. 

Figure 5-1:  Manage Users dialog

NOTE: The procedures outlined below are the same whether you are working in 
the Add Network Scanner Wizard or in the Manage Users dialog.
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Working with Users

Adding Scan Users

Adding a scan user involves granting a network user access to Network Scanning 
Services. 

To add a scan user:

1 If you are not currently working in the Add Network Scanner Wizard, open the 
Xerox Network Scanners (XNS) window. 

2 Select a scanner and choose Manage Users from the Scanner menu. 

3 Do one of the following: 

! For NetWare environments or Windows NTFS partitions: Click New 
and select User from the drop-down box. 

! For all other operating systems (FTP installations): Click New.

4 The Add Users dialog opens. 

Figure 5-2:  Add User dialog boxes

New User dialog for 
NetWare Bindery, NDS, 
and Windows NTFS.

New User dialog for FTP 
installations.
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5 Do one of the following: 

! For NetWare environments or Windows NTFS partitions: The names of 
all network users in the current workgroup, domain, server, or context are 
displayed.

Scroll through the list and select the names of all users who should be 
granted access to network scanning. 

Use the default Windows functionality to select multiple names in a list:

SHIFT-Click: enables you to highlight multiple names in sequence by 
selecting the first and last names in a series.

CTRL-Click: enables you to select several individual names from a list, 
not in sequence.

Click OK once all desired names are selected on the Add Users dialog.

! For all other operating systems (FTP installations): Add each user 
individually. Type the user’s network name and click OK. Continue until all 
names are entered. The entries you type are not validated. You must grant 
users network access to their document folders once the installation is 
complete.

6 Click OK on the Manage Users dialog to finish adding new scan users. 

A document folder and a default template are created on the scan server for each 
enabled scan user. The folders and templates are contained within the 
\CW_SCAN directory on the scan server. See Appendix A for details on the scan 
server configuration.
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Removing Scan Users

Remove scan users by deleting names from the user list in the Manage Users dialog. 
Doing so deletes the user’s document folder (and its contents) from the scan server. It 
also deletes the user’s default scan template. 

To remove a network user’s access to Network Scanning Services:

1 Open the Manage Users dialog from the Scanner menu of the XNS window. 

2 Select the name (or names) you wish to delete in the list of document folders.

3 Click Delete. The document folders and their contents are deleted from the scan 
server.
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Working with Groups
If your organization uses a NetWare Bindery, NetWare NDS, or Windows NT (NTFS) 
network environment, you have the ability to create and organize scan groups. 
Creating groups enables multiple scan users to scan to the same document folder. 
Only one user will have access to monitor the folder. (See Chapter 8, Watch Services 
for more information on monitoring document folders.)

Creating a Group

To create a scan group:

1 Open the Manage Users dialog from the Scanner menu of the XNS window. 

2 Click New and select Group from the drop-down box. The Add Group dialog 
opens. 

Figure 5-3:  Add Group dialog
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3 Type a name and description for the group. This information will help you 
identify the template at a later time.

4 From the list of network users, select the names of all individuals to be added to 
the group. Click Add (or Add All to add all names at once). The names are 
transferred to the Group Members list.

5 Click OK when you finish creating the group. The Scan Folders dialog 
reappears. A group folder is added to the list, and individual folders are included 
for each member of the scan group.

When you use the template to scan from the Document Centre, select the name of the 
group template, not your individual user template.
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Adding Users to Groups

To add users to existing scan groups:

1 Open the Manage Users dialog from the Scanner menu of the XNS window. 

2 Select the folder for the scan group you wish to edit. Click Edit. The Edit Group 
dialog appears. The Group Name and description cannot be edited. 

3 From the list of network users, select the names of the individuals to be added to 
the group. Click Add (or Add All to add all names at once). The names are 
transferred to the Group Members list.

4 Click OK when you finish editing the group. The Scan Folders dialog reappears. 
Folders for new group members are added to the Scan Folder list.

Figure 5-4:  Edit Group dialog
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Removing Users From Groups

To delete/remove individual users from existing scan groups:

1 Open the Manage Users dialog from the Scanner menu of the XNS window. 

2 Select the folder for the scan group you wish to modify. Click Edit. The Edit 
Group dialog appears. (The Group Name cannot be edited.)

3 In the Group Members list, select the names of the individuals you wish to delete 
from the group. 

4 Click Delete. A confirmation appears. 

5 Click OK. The names are removed from the Group Members list and transferred 
to the Users list.

6 Click OK when you finish modifying the group. The Scan Folders dialog 
reappears.

Each specified user’s access to the group document folder will be removed. The 
user’s individual document folders and templates are retained.

Deleting Groups

To delete scanning groups:

1 Open the Manage Users dialog from the Scanner menu of the XNS window. 

2 Select the folder for the scan group you wish to delete. Click Delete. 

The group document folder is deleted and individual user’s access privileges to 
the document folder are removed. 
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Managing Scanner Properties

This chapter contains information which will enable network administrators to easily 
access and edit scanner properties with the network scanning software. The types of 
properties that can be edited include distribution properties, template pool settings, 
default repository settings, and the scanner login name and password.
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Managing Scanner Properties
During the initial scanning installation with the Add Network Scanner Wizard, a 
default scan repository (document folder) and scan template pool are automatically 
created within the scanning configuration directory structure. (See Appendix A for 
details on the scanning configuration directory structure.) Generally, there is no need 
to change the default settings. However, if you wish to change the location of either 
directory or if you wish to add alternate repository locations, you can do so by 
clicking the Advanced button within the Wizard or by modifying scanner properties. 
The Properties dialog contains additional settings for the scanner status, scanner login 
name and password, distribution services, and completed jobs. 

Accessing Scanner Properties

To open the scanner properties dialog:

1 Open the Xerox Network Scanners window, and select a scanner.

2 From the Scanner menu, choose Properties.

- OR -

Right-click the scanner name, and choose Properties. 

The Properties dialog appears.

The following sections describe how to set or change the Document Centre scanner 
properties.
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Status Properties

The Status tab displays the current operating status of the scanner.

Checking the Scanner Status

To check the status of the Document Centre scanner:

1 Open the scanner Properties dialog.

2 Click the Status tab. The current operating status of the scanner is displayed.

Figure 6-1:  Document Centre Properties—Status tab
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Distribution Properties

The Distribution tab contains information about the location of the scan distribution 
server and any installed scanning services.

Establishing the Distribution Server

Select Make this PC the Distribution Server on the Distribution tab to turn the 
machine you are using into a Distribution Server for the scanning installation. The 
Distribution Server monitors the Inbox directory on the scan server for activity and 
manages the distribution of files to E-Mail, Fax, and other image-aware applications. 

See Chapter 4, Enabling Scan to E-Mail and Distribution for more information.

Figure 6-2:  Document Centre Properties—Distribution tab

The Add and Remove 
buttons enable you to 
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Verifying Installed Services

The Installed Document Services field on the Distribution tab lists any Network 
Scanning Services supported by the current scanning installation. Check this field to 
verify which services you are currently supporting. 

Scanner Settings

The Settings property tab displays the location of the scan template pool and enables 
you to set or modify the Document Centre Login name and Password for the template 
pool. The Settings tab also provides access to Advanced Properties which contain 
information about the Default Scan Repositories.

Figure 6-3:  Document Centre Properties—Settings tab
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Checking the Location of the Scan Template Pool

The template pool is the location where scan templates are stored on the scan server. 
The template pool is automatically created during the scan server installation. 

To determine the location of the template pool:

1 Open the scanner Properties dialog.

2 Click the Settings tab.

3 The template pool directory is identified under the Template Pool Settings. 

Changing the Scanner Login Name and Password

The Document Centre scanner requires Read/Filescan access to the scan template 
pool and the user’s document folders on the scan server. The scanner password is 
typically established during installation. However, you can quickly change the 
password or login within the Properties dialog. (See Figure 6-3 on page 6-5.)

To change the scanner login name and/or password:

1 Open the scanner Properties dialog.

2 Click the Settings tab.

3 Type the new scanner login name in the Document Centre Login Name field. 

4 Type the new password and verify it in the Password fields. 

5 Click Apply.
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Changing Default Scan Repository Settings

Distribution templates that don’t specify a scan destination are stored in the default 
repository. Document Centres 240, 255, 265, 460, and 470 have a single default 
repository. Document Centres 220, 230, 332, 340, 420, 432, and 440 enable you to 
create up to four alternate repositories. 

To change default or alternate repository settings:

1 Open the scanner Properties dialog.

2 Click the Settings tab.

3 Click Advanced.

4 Select whether you are using a NetWare network or are connecting to the file 
server via TCP/IP. The associated server fields will vary based on the type of 
connection you use.

5 Enter the machine’s IP address or server information.

! For NetWare: Type the server name, volume, NDS Context, or NDS tree, as 
appropriate for your environment.

! For all other networks: Type the file server’s IP address and port (if used).

6 Enter the path to the template pool. 

7 Type the scanner login name in the Document Centre Login Name field. 

8 Type the Password and verify it in the Password fields. 

9 Click Apply.
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General Properties
Document Centres 240, 255, 265, 460, and 470 have some additional controls on the 
Advanced Settings General Tab. These settings cannot be accessed through the 
Properties dialog for other Document Centre scanners.

Figure 6-4:  Document Centre Properties—General Advanced Settings tab
Document Centres 240/255/265 and 460/470 only
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Setting the Confirmation Report Default

The Request Confirmation Report option enables Network Administrators to set a 
general default so that a confirmation report is generated with each scan job. This 
feature is available for DC 240, 255, 265, 460, and 470 only.

To set the Confirmation Report default:

1 Open the scanner Properties dialog.

2 Click the Settings tab.

3 Click Advanced and choose the General tab.

4 Select the Request Confirmation Report checkbox to make sure a confirmation 
report is generated for each job. Deselect the option if you do not want to 
generate confirmation reports.

5 Click OK.
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Enabling Template Pool to Refresh Daily

This option ensures that the Document Centre scanner will poll the Template Pool at 
least once daily to refresh the list of templates displayed at the scanner. This feature is 
available for DC 240, 255, 265, 460, and 470 only.

1 Open the scanner Properties dialog.

2 Click the Settings tab.

3 Click Advanced and choose the General tab.

4 Select the Refresh Template Pool Daily checkbox.

5 Click OK.
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Completed Job Properties
Network Administrators with Supervisor, Administrator, or equivalent rights can 
control the manner in which the history for distribution jobs is displayed to users. By 
using the settings available on the Completed Jobs tab, Administrators can control 
whether a job history is maintained, how long the history will be retained (up to 30 
days), and can clear the history record at any time.

To learn more about scan job history, see Chapter 10, History.

Figure 6-5:  Document Centre Properties—Completed Jobs tab
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Enabling or Disabling Scan Job History

Enabling or disabling scan job history allows Network Administrators to control 
whether users can access a history log of scan jobs processed through the distribution 
server.

To enable or disable scan job history:

1 Open the Xerox Network Scanners window.

2 From the Scanner menu, choose Properties. The Properties dialog opens. 

3 Choose the Completed Jobs tab.

4 To maintain a history of scan jobs, select Log History of Completed Jobs. 
To disable job history, deselect Log History of Completed Jobs. 

Modifying the Length of Time Job History is Retained

To change the number of days that job history will be retained:

1 Open the Xerox Network Scanners window.

2 From the Scanner menu, choose Properties. The Properties dialog opens. 

3 Choose the Completed Jobs tab.

4 Type the desired number of days (1 - 30) or use the up or down arrows to modify 
the number of days the job history should be retained.

Clearing the History Record

To erase an existing history record:

1 Open the Xerox Network Scanners window.

2 From the Scanner menu, choose Properties. The Properties dialog opens. 

3 Choose the Completed Jobs tab.

4 Click Clear History.
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Distribution Templates

This chapter describes what scan distribution templates are and how they are used. It 
also contains detailed instructions for creating, editing, renaming, and deleting 
distribution templates.

About Distribution Templates
Distribution templates control the processing of scanned documents. Just as a word 
processing template controls the way a document looks, a distribution template 
contains specific details on how documents are processed. Templates can 
automatically control characteristics such as:

! the scan destination (a document folder, fax, E-Mail, Microsoft Exchange 
folders)

! the output format for a scanned document (TIFF, Multi-page TIFF, PDF)

! lightness, darkness, and contrast settings

! scan resolution and auto exposure

! whether the TIFF file needs to be converted to editable text—Optical Character 
Recognition (OCR) 

! fax delayed send options
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Distribution templates are stored in a directory folder on the scan server known as the 
template pool. The Network Administrator configures each Document Centre scanner 
to communicate with a specific template pool. More than one Document Centre can 
access a single template pool; however, this practice is not recommended. If a 
template is modified or deleted, the changes will impact the template’s use from all 
machines. The scanner can download up to 250 templates from the template pool. 
Distribution Templates can be created once and used repeatedly.

User Templates
A distribution template is created for each scan user when the Administrator sets up 
Scanning Services on the network. A user’s template is identified by the network user 
name followed by an .xst file extension. For example, elukas.xst is the default 
template name for the network user, elukas.

A user’s default template will scan documents to his or her document folder on the 
scan server. 

Figure 7-1:  Distribution Templates
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Default Template
When Network Scanning Services is installed, a general default template is created 
on the scan server. This template is called default.xst. Documents scanned with this 
template are stored on the scan server in a separate document folder known as the 
Network Scanning Public Repository. All enabled scan users have Read/Write access 
to the public repository. The diagram below illustrates different document 
destinations based on the type of template used to scan the job. 

Figure 7-2:  Default Template Destinations
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The Distribution Template Window
The Distribution Template Window is very similar in appearance to the Xerox 
Network Scanners Window; however, instead of displaying a list of scanners, it lists 
the names of any available distribution templates on the scan server.

Opening the Distribution Template Window

To open the Distribution Template Window:

1 From the Xerox Network Scanners Window, select a connected Document 
Centre in the list of available scanners.

2 Double-click the scanner name.

- OR -

Select Scanner > Open Templates.

The Distribution Template Window opens. 

Figure 7-3:  Distribution Template Window
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Opening Template Files

To view the Properties for an individual template:

1 Select a template from the list of distribution templates.

2 Double-click the template name.

- OR -

From the File Menu, select Open. 

The Template Properties appear.

Figure 7-4:  The Template Properties dialog
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Creating and Editing Distribution Templates
Creating Distribution Templates involves selecting your preferences in four primary 
areas:

! Choosing the Template Destination (the Distribution tab)

! Enabling Optical Character Recognition (OCR) (the General Folders tab or 
General E-Mail tab)

! Setting Scan Processing Options (the Scan Settings tab)

! Setting Document and Image Options (the Advanced Options tabs)

Each category is explained in detail on the following pages.

NOTE: When you create scan templates, you can start with a completely new 
template (as these instructions will describe) or you can select an existing 
template, rename it, and simply edit the current settings. For more information on 
renaming templates, see Renaming Distribution Templates on page 7-34.
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Choosing the Template Destination
The Distribution tab appears first when you open a distribution template. Template 
destinations can be added, deleted, or edited from the Distribution dialog.

The Destinations list shows any destinations to which the template is currently set to 
scan. A single distribution template can scan to multiple destinations. Beside each 
destination is an icon representing the destination type. The first time you open the 
Distribution tab, it shows only your default template destination—typically your 
document folder on the scan server. As you add more destinations to the template, 
they appear in the Destinations list. 

Figure 7-5:  The Distribution tab
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When you create a scan template, you have several scan destination options:

! Folder—scan a document and store the electronic version in a specific document 
folder (directory) on a network file server. (See Creating a Scan-to-Folder 
Template below.)

! E-Mail—scan a document and E-Mail it directly to any names you include in the 
E-mail distribution list. You can mail the TIFF file or an editable text version. 
(See Creating a Scan-to-E-Mail Template on page 7-12.)

! Fax—scan a document and fax it directly to any people you include in the fax 
distribution list. (See Creating a Scan-to-Fax Template on page 7-14.)

! Exchange Public Folders—scan a document and send the electronic version 
directly to a specific Microsoft Exchange Public Folder. (See Creating a Scan-to-
Exchange Public Folder Template on page 7-16.)

Creating a Scan-to-Folder Template

Scan-to-Folder templates enable you to store scanned images or converted text 
(OCR) in a specific directory on a file server. 

To create a Scan-to-Folder template:

1 From the Distribution Template window, double-click New Distribution 
Template. A new template opens. 

2 On the template Distribution tab, do one of the following:

! Select Add > Folder for the first template you create.

- OR -

! Select Add > Folder > Other for any subsequent templates.
istribution Templates



The General Folders tab appears. The Destinations list shows the user name for 
all network users and groups that have access to network scanning. 

3 Select a document folder or several folders in the Destinations list. Each folder is 
typically identified by the network user name of the scan user. For example, the 
document folder for network user elukas would be named: 

elukas on \\<server name> <directory name>.....

Continue with Step 4 to specify a destination not shown in the Destinations list or 
skip to Step 5.

Figure 7-6:  Distribution Template—General Folders tab
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4 To choose an alternate destination, click Other. The Other Destination dialog 
appears.

a) Select the protocol or Network Operating System of the server to which you 
will be scanning. 

For NetWare: You must know either the Server Name or the NDS Tree and 
Context for the destination server as well as the Server Volume and network 
path to the directory folder.

For all other Operating Systems: You must know the IP address of the 
destination server and the network path to the document folder.

Figure 7-7:  Other Destination dialog—TCP/IP and NetWare NDS
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b) Indicate how the Document Centre will log on to the destination server. 

Select Guest or Anonymous Login if you don’t have a specific user ID for 
the Document Centre.

Select Document Centre Login Name and type the name if a specific user 
ID has been created for the Document Centre. 

c) Click OK to save the settings and return to the General Destinations list. 
The new destination appears in the list.

5 In the Attachments list, indicate whether you want to produce only graphic 
images of the scanned document, editable text, or a combination of both. 

Refer to Enabling Optical Character Recognition on page 7-19, or click Help for 
more detailed instructions.

6 Continue with Setting Scan Processing Options on page 7-21, or click OK to 
close the template properties.

7 Type a name for the template that will help you identify it in the future. Click 
OK.

NOTE: To scan to more than one location at a time or to use additional 
services such as OCR, you must have guest access to the destination 
server.

You can specify a Document Centre Login Name only if you are scanning 
to a single destination without using additional services. 
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Creating a Scan-to-E-Mail Template

Scan to E-Mail templates enable you to send scanned documents via E-Mail directly 
to any names you include in the E-Mail Recipients list. You can mail the TIFF file, an 
editable text version, or both.

To create a Scan-to-E-Mail template:

1 From the Distribution Template window, double-click New Distribution 
Template. A new template opens. 

2 On the template Distribution tab, do one of the following:

! Select Add > E-Mail for the first template you create.

- OR -

! Select Add > E-Mail > Other for any subsequent templates.

The General E-Mail Settings tab appears.

Figure 7-8:  Distribution Template—General E-Mail Settings tab
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3 Click Address Book to access your E-mail address book. Select the name or 
names you want to add to the template. 

If you don’t have the correct name and address in your address book, follow the 
procedures specific to your mail system to add a new recipient. 

Close your address book to return to the template General E-Mail Settings tab.

4 In the Attachments list, indicate whether you want to mail only graphic images of 
the scanned document, editable text, or a combination of both.

Refer to Enabling Optical Character Recognition on page 7-19 or click Help for 
more detailed instructions.

5 Click OK to return to the Distribution tab. The E-Mail addresses and/or names of 
anyone you added to this template will appear in the Destinations list.

6 Click the Scan Settings tab to continue creating your template, or click OK to 
close the template properties. 

7 A message appears reminding you that a distribution server must be enabled on 
your network before you can use this type of template. If you are not sure if a 
distribution server has been enabled, check with your Network Administrator. 
Click OK to continue. 

8 Type a new name that will help you identify the template in the list of templates 
at the scanner. Click OK.

NOTE: The use of personal groups or distribution lists is not supported 
by the scanning software; however, you can mail to global distribution 
lists.
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Creating a Scan-to-Fax Template

Scan-to-Fax templates enable you to scan documents and fax them directly to any fax 
number you include in the fax distribution list.

To create a Scan-to-Fax template:

1 From the Distribution Template window, double-click New Distribution 
Template. A new template opens. 

2 On the template Distribution tab, do one of the following:

! Select Add > Fax for the first template you create.

- OR -

! Select Add > Fax > Other for any subsequent templates.

The Fax Setup dialog appears.

Figure 7-9:  Distribution Template—Fax Setup tab
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3 Click Add to add a number to the fax Recipients list. The Enter new fax phone 
number field appears.

4 Type the phone number of the intended fax recipient. If you wish to add more 
phone numbers, click Add again and repeat the process.

5 Select the appropriate Delivery option. 

! Immediate—The fax is sent immediately when a document is scanned with 
this template. 

! Fax Start Time—Regardless of the time a document is scanned, it will not be 
faxed until the specified time. Place the cursor in the time field and type the 
desired time to send a fax. Use the Up or Down arrows to select AM or PM.

6 Click OK to close the Fax Setup dialog.

7 Continue with Setting Scan Processing Options on page 7-21, or click OK to 
close the template properties.

8 Type a name for the template that will help you identify it in the future. Click 
OK.
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Creating a Scan-to-Exchange Public Folder Template

Scan-to-Exchange Public Folder templates enable you to scan documents and store 
the files in a specific Microsoft Exchange Public Folder on your network. 

To create a Scan-to-Exchange Public Folder template:

1 From the Distribution Template window, double-click New Distribution 
Template. A new template opens. 

2 On the template Distribution tab, do one of the following:

! Select Add > Exchange Public Folder for the first template you create.

- OR -

! Select Add > Exchange Public Folder > Other for any subsequent 
templates.

3 The General Exchange Public Folder Settings dialog appears.

Figure 7-10:  Exchange Public Folder Settings
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4 Type the name of the public folder in which you wish to stored scanned 
documents or click Browse and locate the folder on the network.

5 In the Attachments list, indicate whether you want to produce only graphic 
images of the scanned document, editable text, or a combination of both. 

Refer to Enabling Optical Character Recognition on page 7-19, or click Help for 
more detailed instructions.

6 Continue with Setting Scan Processing Options on page 7-21, or click OK to 
close the template properties.

7 Type a name for the template that will help you identify it in the future. Click 
OK.
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Removing a Destination
Once you have created a template, the information is saved until you modify the 
template. At some point, you may wish to change the distribution list and may need to 
remove some destinations. 

To remove a destination from a distribution template:

1 From the Distribution Template window, double-click the template you wish to 
modify. 

2 Select the destination(s) you want to delete in the Destinations list.

3 Click Remove. The destination is removed from the list.

4 Click OK when you are finished.
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Enabling Optical Character Recognition
Optical Character Recognition (OCR) enables you to turn TIFF image files into text 
documents which can then be edited in many word processing programs. The OCR 
options within the Network Scanning Services software enable you to specify what 
type of document you are scanning (graphic and/or text) and in what common file 
format the OCR’d document should be saved. 

To set OCR options in a distribution template:

1 In the Attachments list, indicate whether you want to produce only graphic 
images of the scanned document, editable text, or a combination of both:

! Only Images—Select this option for graphics or text files that won’t require 
editing. The scanned document is converted to a TIFF. You can further 
specify TIFF or multi-page TIFF on the Document Options dialog. OCR is 
not available with this option.

! Only TextBridge® OCR Documents—The scanned document is converted to 
a file format (such as .RTF) which can later be edited.

! Both Images and TextBridge® OCR Documents—The scanned document 
contains both images and a converted file format which can later be edited. 

Figure 7-11:  Network Scanning OCR Options on Destinations Dialog

NOTE: Before you can automatically OCR a document, a distribution server must 
have been installed and enabled on your network. Check with your Network 
Administrator to be sure this has been done.
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2 Click OCR Settings and select the file format in which to save the completed 
document. The OCR settings give you numerous format options to choose from, 
including several .PDF combinations, different versions of Microsoft Word, etc. 

Also select the language that should be used for OCR processing. 

Click OK.

3 Click OK to close the Distribution template dialog, or select the Scan Settings 
tab to continue creating your template.
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Setting Scan Processing Options
The Scan Settings tab allows you to control basic processing characteristics about the 
document you’re scanning.

From the Scan Settings tab you can make any of the following selections:

! Original Type—indicate whether the original document is primarily text, 
graphics, or a combination of both. The halftone option is used to generate the 
best quality on scanned photographic images. Color and shade differences are 
represented with varying shades of gray.

NOTE: Not all options are available for all Document Centres. If an item is not 
displayed on the tab or is grayed, it is not available for your system.

Figure 7-12:  Distribution Template Scan Settings tab
Document Centres 220/230, 332/340, and 420/432/440 only

Not all options 
are available 
for all models.
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! 2 Sided Scanning—select whether the original document is one-sided or two-
sided. 

! Print Local Copy—automatically print an extra copy of the document.

! Copies—indicate the number of additional document sets to print at the 
Document Centre.

! Output/Stapling—indicate whether the additional printed document should be 
stapled or not.

! Request Confirmation Report—prints a report at the Document Centre indicating 
the status of the scan job. 

! Suppress Job Log—When this option is enabled, only the scanned images will be 
filed in the document folder. When the option is disabled, both the scanned 
images and a job log file (.xst) will be filed in the document folder.

! Advanced—opens the Advanced Settings tabs and provides access to Document 
Options, Image Options, and Image Adjustment Options.

For more information on available options, click Help.

Setting Document and Image Options
The Document Options, Image Options, and Image Adjustment Options tabs are 
grouped together under a category called Advanced options. These Advanced options 
give you the opportunity to fine tune the manner in which your document will be 
scanned.
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To access scanning Advanced options:

1 Open a scan template and choose the Scan Settings tab.

2 Click Advanced. The Document Options, Image Options, and Image Adjustment 
Options tabs appear. 

Figure 7-13:  Distribution Template Document Options tab
Document Centres 220/230, 332/340, and 420/432/440 only
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Defining the Original Document Size

The Document Centre scanner has the ability to automatically detect the size of the 
document you are scanning, or you can specify a particular paper size.

To specify the Original Document Size in a distribution template:

1 Click Advanced on the template Scan Settings tab to access the Document 
Options tab. 

2 From the Original Size box, select the size of the paper document you will be 
scanning, or:

! To have the scanner automatically detect the size of the document, select 
Auto.

! To specify a document size not currently listed, select Custom and type the 
dimensions in the Width and Height fields.

NOTE: Custom paper sizes are available only for documents scanned from the 
document glass at the Document Centre. They cannot be specified for documents 
scanned from the automatic document feeder.
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Reducing or Enlarging Document Size

A document image can be scaled between 25 and 400 percent of its original size. 
However, if the document is fed through the document feeder, the scaling range is 
limited to from 50 to 200 percent of the original size. Reducing or enlarging an image 
does not change the paper size. 

NOTE: Not all options are available for all Document Centres. If an item is not 
displayed on the tab or is grayed, it is not available for your system.

Figure 7-14:  Distribution Template Scan Settings tab
Document Centres 220/230, 332/340, and 420/432/440 only

Not all 
options are 
available for 
all models.
Creating and Editing Distribution Templates 7-25



7-26
To reduce or enlarge a document image in a template:

1 Click Advanced on the template Scan Settings tab to access the Document 
Options tab. (See Figure 7-13 on page 7-23.)

2 Select Reduce/Enlarge. 

3 Select Auto % or Variable % and enter a percentage to reduce or enlarge the 
image. 

! Auto %—the document image will automatically be scaled to fit the selected 
paper size.

! Variable %—the document image will be resized in direct or varying 
proportion based on the percentage you enter in the width and height fields.
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Specifying the Output File Format

The File Format determines the type of file that will be created from the scanned 
document.

To specify the output file format in a template:

1 Click Advanced on the template Scan Settings tab to access the Document 
Options tab. (See Figure 7-13 on page 7-23.)

2 Select one of the following from the File Format list box: 

! TIFF—each page of the document will be stored as a separate TIFF image 
file.

! Multi-Page TIFF—multi-page documents will be stored as a single TIFF 
image file. This format is useful for Scan to File or Scan to E-Mail 
operations. 

NOTE: Documents can also be saved to PDF and numerous other 
document formats by selecting the appropriate option in the TextBridge 
OCR settings. See Enabling Optical Character Recognition on page 7-19 
for more information.
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Setting the Filing Policy

Although there are many important aspects to a scan template, the filing policy is one 
of the most crucial to understand. The filing policy specifies the method used to store 
scanned documents in a document folder. 

To specify the document filing policy in a template:

1 Click Advanced on the template Scan Settings tab to access the Document 
Options tab. 

2 Select the desired filing policy from the list of available options. 

The four filing options are described below. 

! Overwrite Existing File—deletes any TIFF files stored in the document folder 
before sending the newly scanned files of the same name. All deleted files are 
lost.

! Append to Existing File—adds data from newly scanned files to the existing files 
(of the same name) in the document folder. Existing files are not deleted. Delete 
old files on a regular basis to conserve server space.

! Do Not Save—determines if any files with the same name already exist in the 
document folder. If no files exist, the newly scanned files are sent to the folder. If 
files with the same name already exist in the folder, the scan job is aborted.

! Rename New File—behavior varies based on your Document Centre model. 
Although this is the safest filing policy, it requires a large amount of disk space. 
(This is the default setting.)

! Document Centres 220, 230, 332, 340, 420, 432, and 440—a new .xsm 
folder is created (based on the time and date of creation) into which the TIFF 
images are filed. 

Figure 7-15:  Document Options Filing Policy

Output File Format
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! Document Centres 240, 255, 265, 460, and 470—an alphanumeric name 
(limited to 8 characters) is generated for the .xsm folder based on the 
document name specified in the template. The folder names increment 
sequentially when additional documents are scanned to this location. For 
example, if the document name specified in the template was scanning, the 
first document folder would be called scanning.xsm. Any subsequent jobs 
scanned with the same template to the same destination would be named 
scann000.xsm and scann001.xsm, respectively. 

Editing Image Darkness, Contrast, and Sharpness

The degree to which you are able to control image settings is dependent on the type of 
Document Centre scanner you own. Some scanners enable you to modify lightness 
and darkness, contrast, and sharpen or soften the image, while others allow you to 
adjust lightness and darkness only. 

Figure 7-16:  Distribution Template Image Adjustment tab
Document Centres 240, 255, 265, 460, and 470 only
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To modify template image settings:

1 From the distribution template Scan Settings tab, click Advanced.

2 Choose the Image Adjustment tab.

3 Use the sliding scales to adjust each of the available settings:

! Lightness/Darkness—Move the scale to the left to lighten the image. Move it 
to the right to darken the image.

! Contrast—Move the scale to the left to lessen the contrast. Move the scale to 
the right to increase contrast.

! Sharpen/Soften—Move the scale to the left to make the edges of the image 
appear darker or more pronounced. Move the scale to the right to make the 
image edges appear softer or less defined in the scanned document. 

NOTE: Not all options are available for all Document Centres. If an item is not 
displayed on the tab or is grayed, it is not available for your system.
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Setting the Scan Resolution

Use the Resolution Mode/Resolution setting to set the resolution of the output 
document. This setting does not need to match the resolution at which the original 
document was printed. A 600 dpi image produces a finer, higher quality image than a 
300 dpi setting. However, a 600 dpi resolution will result in a larger file size. 
Consider these factors when you make your selection.

To set the resolution of the scanned document:

1 From the distribution template Scan Settings tab, click Advanced.

2 Choose the Image Options tab.

3 Choose the desired resolution from the available options.

Figure 7-17:  Document Centres 220, 230, 332, and 340 Image Options tab
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Using Auto Exposure

Auto Exposure enables you to enhance the output of documents that have color 
backgrounds. When Auto Exposure is enabled, the scanner automatically selects an 
exposure level that is appropriate for the original document. When Auto Exposure is 
off, the scanner uses the template’s Lightness/Darkness settings to control the 
exposure level of the produced image.

To enable Auto Exposure:

1 From the distribution template Scan Settings tab, click Advanced.

2 Choose the Image Options tab. (See Figure 7-17 on page 7-31.)

3 From the Auto Exposure list box, choose one of the following:

! Off—The auto exposure feature will not be used in this template.

! Lead Edge—The scanner bases the auto exposure on the characteristics of 
the first few lines of whichever side of the page is fed into the scanner first.
Distribution Templates



Erasing Lines Around the Edge of a Page

The Edge Erase option enables you to erase spots, punch holes, staple marks, or any 
other dark marks that may appear around the edge of your original document. You can 
erase marks which appear in the outer 0 to 50 mm of the page, or up to 2 inches. 

To erase lines and marks around the outer edges of a document:

1 From the distribution template Scan Settings tab, click Advanced.

2 Choose the Image Options tab.

3 Select Edge Erase and do one of the following:

! Select All Sides the Same to indicate that all edges should be erased 
proportionately. 

- OR -

! Ensure that All Sides the Same is not selected, and type the appropriate 
space to erase around each edge of the document. 

NOTE: Not all options are available for all Document Centres. If an item is not 
displayed on the tab or is grayed, it is not available for your system.
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Renaming Distribution Templates
Network Scanning Services enables you to easily rename distribution templates. 

To rename a distribution template using the Network Scanning Services 
software:

1 In the Distribution Template window, select the template you want to rename.

2 Select File > Rename and type the new template name.

Deleting Distribution Templates
If you no longer need a distribution template, you can delete it from the list of scan 
templates. To do so, you must possess Write access to the template pool.

To delete scan templates:

1 Open the Distribution Template window.

2 Select the template you want to delete and do one of the following:

! Click the Delete icon on the toolbar.

- OR -

! Press Delete on the keyboard.

The template is deleted from the template pool on the scan server.

NOTE: Template names cannot exceed 20 characters. For compatibility 
with the Document Centre, do not include spaces or "@" in the name. 
Distribution Templates
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Watch Services

This chapter describes watch services and their use. It also contains detailed 
instructions for creating, editing, and removing a watch service.

About Watch Services
When documents are scanned at the Document Centre, the electronic files are sent to 
a document folder on the scan server. A document folder is created for each scan user 
at the time the Administrator installs Network Scanning Services. Each user’s folder 
name matches his or her network login name. When the network scanning software is 
installed on a user’s workstation, a watch service is automatically established to 
monitor any activity that occurs in that user’s document folder on the scan server. 

Figure 8-1:  Watching a Document Folder

User: elukas

elukas 
Document 

Folder

CentreWare Watch Service
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Each user can watch more than one document folder. If the scan server is running on a 
NetWare or Windows NT server, a watch service is established for all document 
folders to which the user has Read/Write privileges under the current network name. 
This means that if your workstation and network login are both elukas, a watch is 
automatically established for any document folders to which you have Read/Write 
access. However, if your workstation login was ekibler and your network login was 
elukas, the scanning software will not automatically watch for documents in your 
document folder. In this circumstance, you should use the Add Watch Wizard to set up 
a watch on the document folder.

For all other network operating systems, you must always use the Add Watch Wizard 
to establish a watch. See Working With Watch Services on page 8-6 for additional 
information.
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When to Use CentreWare Watch Services
The scanning software distributed with the Document Centre scanner actually 
includes two different software packages: CentreWare Network Scanning Services 
software and a supplemental Scan to PC Desktop™ kit. Each software package 
contains a watch utility to monitor document folders for activity. If you install both 
the Network Scanning Services software and the Scan to PC Desktop™ software, you 
must understand which "Watcher" to use to accomplish your goals.

! The CentreWare Watch Service monitors your document folder and offers you the 
flexibility to choose among three different processing options which are 
automatically performed when a scanned document appears in the folder. (See 
Adding a Watch Service on page 8-6 for more information.) 

! The Xerox Document Centre Image Retriever (included in the Scan to PC 
Desktop™ kit) is designed specifically to enable scanning to your PaperPort 
desktop. This utility monitors your document folder and automatically moves 
any scanned documents into PaperPort on your PC desktop.

Although the CentreWare Watcher can be configured to scan to PaperPort, it only 
supports the multi-page TIFF file format. The Xerox Document Centre Image 
Retriever supports single-page TIFF, multi-page TIFF, and PDF formats. See 
Appendix B for more information on configuring the CentreWare Watcher to scan to 
PaperPort.

NOTE: CentreWare Watch Services and the Document Centre Image Retriever 
must be installed and set up separately. You cannot monitor the same document 
folder with both utilities.
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The Watch Folder Window
The Watch Folder Window displays the names of, and network path to, any document 
folders currently being watched from your PC. The Watch Folder Window can be 
opened from either the Xerox Network Scanners (XNS) Window or from the 
Windows taskbar.

To open the Watch Folder Window:

! From the Xerox Network Scanners Folder, click Scanner > Watch Folder.

- OR -

! Right-click the scanning icon in the Windows taskbar, and choose Watch Folder.

The Watch Folder Window opens. 

Figure 8-2:  The Watch Folder Window
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The Watch Folder Window contains the following features:

! Folders—lists the names of any document folders currently being watched by 
this PC.

! Add—launches the Add Watch Wizard so you can add a new watch service or 
watch new document folders.

! Remove—deletes a folder from the watch list.

! Properties—displays the current settings for the selected document folder.

! Refresh Interval—changes the frequency at which any document folders you are 
currently watching are polled for activity.

! Automatically check for new documents when my computer starts—checks the 
document folder for scanned documents each time the PC is started.
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Working With Watch Services

Adding a Watch Service
Use the Add Watch Wizard to add new folders to monitor for the arrival of scanned 
documents. The wizard enables you to set one of three different service options:

! Display a message when documents arrive—sends a message to your PC desktop 
when a scanned document appears in the folder. (This is the default.)

! Move to another directory or folder—automatically moves the scanned 
document to a new location that you specify. You can use this option to move 
documents from the network server onto your workstation.

! Open with an application—automatically opens the scanned document for 
viewing on your PC desktop, using any application you specify that is capable of 
reading TIFF images. When you use this option, the scanned image remains in 
the document folder on the scan server.

Figure 8-3:  Watch Folder Wizard

NOTE: For information on using watch services with PaperPort, see 
When to Use CentreWare Watch Services on page 8-3.
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Receive Notification When Documents Arrive in a Watch Folder

To receive a message on your desktop when files appear in your Watch 
folder:

1 Open the Watch Folder window, and click Add. The Add Watch Wizard opens.

2 Type the path of the folder to watch, or click Browse and locate the folder on 
your network. 

Click Next once the correct path is listed.

3 Select Display a message when documents arrive and click Next. 

4 Confirm that the correct service is displayed on the dialog. Click Finish to 
complete the setup.

When documents are scanned to this document folder, a message similar to the 
following is displayed. 

Figure 8-4:  Message Generated with "Notify Me" option
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Move Scanned Documents to Another Directory or Folder

To automatically move scanned documents from your document folder 
to another directory: 

1 Open the Watch Folder window, and click Add. The Add Watch Wizard opens.

2 Type the path of the folder to watch, or click Browse and locate the folder on 
your network. 

Click Next once the correct path is listed.

3 Select Move to another directory or folder and click Next. 

4 Type the path to the directory where you want to save scanned documents or 
click Browse and locate the directory.

Click Next on the Move Documents to dialog.

5 Confirm that the correct path is displayed on the dialog. Click Finish to complete 
the setup.

When documents are scanned to this document folder, they are automatically moved 
to the new location.

Open Scanned Documents With a Program

To open scanned documents with a specific program: 

1 Open the Watch Folder window, and click Add. The Add Watch Wizard opens.

2 Type the path of the folder to watch, or click Browse and locate the folder on 
your network. 

Click Next once the correct path is listed.

3 Select Open with an application and click Next. 
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4 Type the path to (or browse to the location of) the directory on your hard drive 
that contains the executable (.exe file) you wish to use to automatically open any 
scanned documents that appear in the Watch folder. You must use an application 
capable of reading TIFF images or one that can open TIFF files using command 
line arguments. (Refer to Help for more information.)

5 Click Next.

6 Confirm that the correct path is displayed on the dialog. Click Finish to complete 
the setup.

When documents are scanned to this document folder, they are automatically opened 
on your desktop using the specified program. The files remain in the scan document 
folder unless you move or copy them to a new location.

Figure 8-5:  The "Open With" Watch Service 

In this example, 
files will be opened 
with Paint Shop 
Pro.
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Modifying a Watch Service
You can modify an existing watch service by running the Watch Folder Wizard and 
changing current settings.

To modify a watch service:

1 Open the Watch Folder window.

2 Select a folder in the list of folders currently being watched.

3 Click Properties. The Add Watch Wizard opens and shows the current settings 
for the existing Watch.

4 Move through the Wizard screens and make any desired changes.

5 Confirm that the correct service is displayed on the dialog. Click Finish to 
complete the setup.

Removing a Watch Service

To stop watching a specific document folder:

1 Open the Watch Folder window.

2 Select a folder in the list of folders currently being watched.

3 Click Delete. The folder name is removed from the list of Watch folders and will 
no longer be monitored for scan activity.
atch Services
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Scanning A Document

This chapter contains basic instructions for scanning a document from the following 
Document Centre models:

! Document Centres 220 and 230 ST

! Document Centres 332 and 340 ST

! Document Centres 240, 255, and 265 ST

! Document Centres 420, 432, and 440 

! Document Centres 460 and 470 

More detailed information can be obtained in your Document Centre user guide.
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Scanning from DC 220/230 ST, 
DC 332/340 ST, or DC 420/432/440
To scan a document:

1 At the Document Centre, load the document just as you would to make a copy. If 
you use the document feeder, place the document in the tray so the top of the 
page feeds in first. 

2 Press Features and choose Scan on the Touch Screen. Select Refresh List to 
update the list of templates. If you’ve modified a specific template, select Update 
Template. 

3 Scroll down the list and select the template associated with your network user 
name (your default template) or another template you have created.

4 Press Start.

NOTE: Templates with the "@" symbol in the beginning of the name are 
created with Internet Services. These templates cannot take advantage of 
the distribution capabilities of Network Scanning Services.

Document Feeder Paper Orientation

Correct Incorrect
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Scanning from DC 240/255/265 ST or 
DC 460/470
To scan a document:

1 At the Document Centre, load the document face up in the automatic document 
feeder. 

2 On the Touch Screen, press Features and select Network Scanning. A list of 
scan templates is displayed. 

3 Press More Scan Features and select Update Template List.

4 Press Update Template List again and Confirm.

5 Press Basic Scanning and scroll down the list of scan templates to choose the 
desired template. 

6 Press Start.

NOTE: Templates with the "@" symbol in the beginning of the name are 
created with Internet Services. These templates cannot take advantage of 
the distribution capabilities of Network Scanning Services.

Document Feeder Paper Orientation

default orientation scanner can also be programmed to 
accept this orientation
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History

This chapter contains information about the Network Scanning Services History 
Window. It instructs scan users on how to use the history window to check the 
processing status of their distribution scan jobs and includes instructions for Network 
Administrators on how to set History Properties.

About the History Window
The History Window allows network administrators and scan users to view the history 
and status of scan jobs. It displays a summary of any scan-to-distribution jobs (such 
as scan to E-Mail, scan to a document folder with OCR, or scan to other applications) 
and information on their success or failure. History information can be retained for a 
maximum of 30 days.

History information is stored on the scan server in a file called history.txt located in 
the \CW_SCAN\CONFIG directory. By default, all enabled scan users have access to 
the history information, but they cannot clear the history log or change the number of 
days history information is saved. Only Network Administrators can modify the 
History settings. See Setting History Properties on page 10-5 for more information.
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Opening the History Window
To open the history window:

1 Open the Xerox Network Scanners Window.

2 From the Scanner menu, choose View History. The History Window opens.

Figure 10-1:  The History Window
History



Checking the Status of a Scan Job
The scan job history tracks scan processing as it relates to CentreWare software. If 
your scan templates are designed to interact with other software applications, the 
History window cannot verify the success or failure of that software.

To open the history properties dialog:

! Double-click the Scan ID icon for the job whose history you want to view. The 
history properties dialog opens.

Figure 10-2:  History Properties
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There are four possible processing states that may display in the history window:

! Processing—the scan job processing is still in progress. 

! Completed—the scan job was completed successfully and was delivered to all 
destinations.

! Completed with Errors—the scan job was completed, but could not be delivered 
to one or more destinations. Some destinations were processed successfully.

! Failed—the scan job could not be processed; all destinations failed.
History



Setting History Properties
Network Administrators with Supervisor, Administrator, or equivalent rights can 
control the manner in which scan job history is displayed to users. By using the 
settings available on the Completed Jobs tab, Administrators can control whether a 
job history is maintained, how long the history will be retained (up to 30 days), and 
can clear the history record at any time. 

For more information on setting history properties, see Completed Job Properties on 
page 6-11.

Figure 10-3:  Completed Jobs tab 
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The Job Log
When a scan job is processed, the distribution template is filed in the document .xsm 
folder along with any TIFF images, converted (OCR’d) files, and other configuration 
files. After processing is completed, the distribution template file (.xst) becomes the 
job log. The job log contains information about the original template characteristics 
as well as additional information about how the job was actually processed. 

NOTE: The job log may be helpful for problem solving, but you should first check 
the Document Centre Configuration Report or the History record (for distribution 
scan jobs). 
History
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Uninstalling Network Scanning Services

Uninstalling the network scanning software involves performing two separate tasks:

! uninstalling the scan server software (for Administrators only)

! uninstalling workstation software

Uninstalling the Scan Server Software

CAUTION:This procedure uninstalls the entire \CW_SCAN directory on the scan 
server, including any document folders and the data within them.

You must uninstall the scan server software in the same manner in which it was 
installed. For example, if you used a Windows NT workstation to install the 
software on a Windows NT server, you must also uninstall the server software 
from a Windows NT workstation.
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For NetWare and Windows NT networks: You must possess Supervisor or 
Administrator network access rights to uninstall the scan server software. All scan 
server software will be uninstalled as well as scan-specific groups and access rights. 

For all other network environments: To uninstall software on non-NetWare or 
Windows NT servers, you must possess Read/Write access to the scanner directory. 
The uninstallation will remove the scan server software and will reset the Document 
Centre to factory default settings. However, any individual or group accounts created 
with FTP software will remain.

To uninstall the scan server software if the scanner appears in the Xerox 
Network Scanners window:

1 Open the Xerox Network Scanners folder.

2 Select the scanner you want to uninstall from the list of scanners. 

3 Click Delete. A dialog similar to the following appears:

4 Select Uninstall <scanner name> from the network.

5 A warning message appears. Click Yes to confirm that you want to uninstall the 
scan server software. 

6 Type the scanner (device access) password. 

The scanner is deleted from the Xerox Network Scanners window and all 
scanning software is removed from the server.

Figure 11-1:  Delete dialog
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To uninstall the scan server software if the scanner does not appear in 
the Xerox Network Scanners window:

1 Open the Xerox Network Scanners folder.

2 From the Scanner menu, choose Uninstall Scan Server.

3 Select the operating system of the server containing the scan server software you 
wish to uninstall. 

4 Type the path to the directory which contains the \CW_SCAN directory or click 
Browse to locate the proper directory on your network. 

5 In the example below, the \CW_SCAN directory was created in the \326 
directory, so the path to that directory is specified in the Location field. 

6 Click OK. 

7 Click Yes to confirm that you want to uninstall the scan server software. The 
scanning software and document folders are removed from the server.

Figure 11-2:  Uninstall Scan Server
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Uninstalling the Workstation Software
Use the following procedure to uninstall Network Scanning Services from the 
workstation. 

To uninstall the Scanning Services software from your workstation:

1 If the desktop scanning icon appears in the Windows taskbar, right-click the icon 
and select Exit to close Network Scanning Services. 

Although you may not have any active windows open, the icon in the taskbar 
indicates that scanning applications are still running in the background on your 
PC. 

2 On the Windows desktop select Start > Settings > Control Panel.

3 Double-click Add/Remove Programs.

4 On the Install/Uninstall tab, select Xerox CentreWare Network Scanning 
Services from the list of installed software. 

5 Click Add/Remove. 

6 Click Yes to confirm that you want to remove Scanning Services software from 
the workstation.

7 You may be prompted to uninstall Shared Files. These are files that are also used 
by other CentreWare applications. If you are using other CentreWare 
applications, do not uninstall the shared files. If you won’t be using any 
CentreWare software, click Yes to All and Yes to Proceed.

The software is uninstalled.

8 Click OK to close the uninstallation program.
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Problem Solving

This chapter provides solutions to common problems that you may encounter while 
installing or using the Network Scanning Services software. The issues are grouped 
by the type of user that would commonly encounter the specified problem. 

! Scan Administrators

! Scan Users

The chapter also contains a section which highlights some common error messages 
that may appear on the scanning Confirmation Report and provides a brief 
explanation for each.
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For Scan Administrators 
! I can’t scan. What do I do now?

! Verify that the user account and password for the Document Centre exist.

! Verify that you entered the password correctly.

! If you are running on a Windows NT network, verify that the DCSUSERS 
group has been granted the right to Log on Locally. 

! Check the permissions on the directory to which you are scanning.

! For installations to Windows NT servers and other non-NetWare 
environments, review Part 2: Set Up Installation Directory and Enable FTP 
on page 3-18 to ensure you enabled FTP properly.

! Ensure that FTP access is not limited to anonymous logins only.

! Why can the scanner only retrieve a partial list of templates?

This message indicates that the Document Centre Login Name, Password, or 
Security permissions are insufficient for the machine to log on and retrieve 
templates.

! Verify the template and repository settings using the Document Centre 
Touch Panel. Check the accuracy of the Document Centre network name, 
password, path, server name, volume, IP address, etc.

! Verify that the Document Centre’s network user name and password have 
read access to the template folder. 

NetWare: Log on to the server using the Document Centre network name 
and use Windows Explorer to copy a template file.

TCP/IP: Use FTP from the command line and validate that you can change 
to the template directory (as shown in the Document Centre Touch Panel). 
Then retrieve a template file using the GET function. 

! If you are able to perform the actions above, then both the Document Centre 
and network are set up correctly. Try rebooting the Document Centre by 
turning it off and on. You may need to reboot more than once.
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! Why isn’t the scanner automatically discovered on the network?

! CentreWare will automatically find scan-enabled and configured Document 
Centre scanners on the network. It will search your local subnet for FTP-
enabled scanners as well as any NetWare servers that you are logged into for 
NCP-configured scanners.

If the scanner is not automatically discovered, you will need to map a 
network drive to the scan server and manually enter the location of the 
directory on the scan server which contains the Network Scanning 
\CW_SCAN directory. 

! If you are using SNMP and have modified the default GET/SET names 
Public and Private, review SNMP Community Names on page 3-5.

! Why did I get an Unknown Address message? 

The Unknown Address message means that the Domain Name Service (DNS) 
address is not listed in Host Table. The Document Centre’s IP address must be 
listed in the host table for automatic discovery to occur. Otherwise, your only 
discovery option during installation is to enter the scanner’s IP address. 

! Why can’t I install over Windows NT when I use the Add Network Scanner 
Wizard? 

The domain security features incorporated into CentreWare are only available if 
you are installing from a Windows NT workstation to a Windows NTFS partition 
on the server or if you are installing directly onto the Windows NT server. 

Windows 95 or Windows 98 users can use the FTP Other installation option 
within the Add Network Scanner Wizard and manually set the access privileges 
once the CentreWare installation is complete.
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! How do I create remote repositories? I don’t see the option in the Add 
Network Scanner Wizard. 

The Release 5.20 scanning installation has been simplified and the ability to 
create remote repositories has been removed from the installation wizard. 
Remote Repositories can now be created by specifying an Other folder 
destination in the distribution template properties. 

! I have multiple Document Centre scanners on the network. Why won’t some 
templates work with specific machines? 

Although all scan templates can be stored in the same template pool on the scan 
server, templates are not interchangeable with all scanners. 

In addition, templates created with Internet Services are not interchangeable with 
those created with the Network Scanning Services software.
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For Scan Users
! Why does it take a long time for the Xerox Network Scanners Window to 

open or refresh?

The Xerox Network Scanners Window may take a long time to open if the server 
is running slow or is offline. 

If no scanners are currently installed or configured, the software could take a 
long time to search the network and determine no scanners are installed.

If there are many scanners on your network, the search could take a long time 
because the software needs to obtain the status of each scanner. To reduce the 
search time frame, remove any unused scanners from your scanners list.

! Why can’t I see the scanner I need in the Xerox Network Scanners Window? 

Try to refresh the window display. Doing so updates the list of available 
scanners. 

If that is not successful, you can use the Add Network Scanner Wizard to search 
for a specific scanner on the network. 

Otherwise, check with your Network Administrator. You may not possess proper 
access rights on the network.

! Why don’t I see anything when I open the Distribution Template Window? 

If you have recently uninstalled other CentreWare applications, you may have 
uninstalled some shared files which are required for the scanning operation. If 
not, the original installation may have failed for some reason. Try reinstalling the 
software.

If you are still unable to see the necessary files, consult your Network 
Administrator to ensure that you have the proper access rights.
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! Why can’t I see jobs in the History window? 

Access to the History record is controlled by the Network Administrator. You 
may not have access to it. Check with your Network Administrator. 

The History window only displays jobs that are processed through the scanning 
distribution server—Scan to E-Mail jobs, any jobs which include OCR 
processing, and jobs scanned to other application’s Inboxes.

! I selected some TextBridge OCR options in my template, but the OCR didn’t 
work. Why?

Any automated OCR capability requires the use of a distribution server. Check 
with your Network Administrator to ensure that your network scanning 
configuration includes a distribution server.

! When I selected TextBridge OCR options in my template, I got a message 
indicating that I must be using a distribution server. Why did this message 
appear?

This message is simply a reminder that no OCR functionality can complete 
unless your Network Administrator has enabled a distribution server. 

! Why won’t my scan job complete when I try to select .PDF or .HTML 
formats (TextBridge options) in my distribution template? 

TextBridge has added some new file format options (.PDF, .HTML, and newer 
versions of Microsoft Word) that were not previously supported by older 
Document Centre models. A software upgrade patch for Document Centres 220/
230 ST and 332/340 ST is available to anyone who might need such support. 
Contact your Xerox representative to obtain the upgrade.

! Why can’t I scan to personal E-Mail groups?

The use of personal E-Mail groups or distribution lists is not supported by the 
scanning software; however, you can mail to global distribution lists.
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! We’ve been using the 4.1 Network Scanning Services software and have 
several templates already created. If we upgrade to the 5.20 release, do we 
have to recreate all of our templates?

No. The 5.20 Network Scanning Services software allows you to edit and use 
distribution templates created with release 4.1 software. However, once 
templates are used with the 5.x software, they are upgraded to release 5.x 
compatibility only. 

! When I open the Xerox Network Scanners Window, I see the message 
"Unsupported Installation" beside my scanner name. What does this mean?

This means that your workstation software was upgraded to the 5.20 software 
release before your Network Administrator updated the scan server software. The 
scan server (which is the center of all scan processing) is currently still using a 
previous version. Check with your Administrator for more information. 

! When I tried to update the list of templates at the Document Centre scanner, 
I received a message indicating that the scanner was only able to retrieve a 
partial list of templates. What should I do?

Check with your Network Administrator. He or she will need to verify that the 
Document Centre has sufficient network access.

! Why can’t I delete a template from the template pool?

To delete a distribution template, you must have Write access to the template 
pool. Write access is assigned to each enabled scan user during the installation. 
Check with your Network Administrator to be sure your rights have not been 
changed.

! I can never remember the path to my document folder on the scan server. 
How can I quickly check its contents?

Use the Explore Documents option in the Scanner menu of the Xerox Network 
Scanners window. It opens an Explorer Window which takes you right to your 
document folder on the server.
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! Why isn’t a Watch Service automatically created to monitor my document 
folder? I thought this was always supposed to happen.

A Watch Service is automatically set to watch your document folder (and any 
other document folders to which you possess Read/Write access) as long as your 
PC login and network login names are identical and you are using a NetWare or 
Windows NTFS network. If your login names are different, or if you work in a 
different network environment, you can set up a watch folder using the Watch 
Folder Wizard.

! If I use the "Move To" watch service to move a document out of my 
document folder, the next job I scan appears in my document folder with the 
same name as the first job. Why?

Once you move a document out of the document folder, the scan service is not 
able to detect that the scan job ever existed. It will use the same name for the next 
job that is scanned to the same document folder. 

For example, if a job named 0001.xsm is scanned and moved to your PC desktop, 
the scan service can no longer determine that 0001.xsm ever existed in the 
document folder. Therefore, the next job scanned to the document folder will be 
named 0001.xsm.

! I tried to uninstall the Network Scanning Services software from my 
desktop, but it didn’t seem to work. What did I do wrong?

During the uninstallation, you may see a message indicating that cwscan32.exe is 
still running. If you do not have any active windows open, you may still have the 
scanning desktop icon running in the Windows taskbar. Right-click the icon and 
choose Exit. 

At this point you have not yet uninstalled the scanning software. Return to the 
Add/Remove dialog and complete the network scanning software uninstallation.

! Why won’t my scanning software run after I uninstalled some other 
CentreWare applications?

During the uninstallation, you are prompted to uninstall shared files. These 
shared files enable several different CentreWare applications. If you uninstall the 
shared files, other CentreWare applications may not work. To fix the problem, 
reinstall the Network Scanning Services software on the workstation.
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Common Error Messages
The following list summarizes some of the most common Confirmation Report 
error messages and their possible causes: 

! Login failure. Check user, password, and/or setups.

! If this is an FTP setup, the machine may be logging in to the wrong location. 
Ensure that FTP is set up correctly. 

! User name/account is invalid/incorrect.

! Password is invalid/incorrect.

! Server name is invalid/incorrect.

! NDS Tree (NetWare only) is invalid/incorrect.

! NDS Context (NetWare only) is invalid/incorrect.

! File transfer failed.

! This is a miscellaneous file transfer failure. It can only occur if the network 
or destination server goes down at the exact time file transfer is occurring.

! Destination disk is full. 

! Remote directory lock failed.

Document folders need to be accessed by various components of the Network 
Scanning software. Only one of these components can access a repository at any 
time.

When a scanned document is being processed, a folder with a .LCK is placed in 
the document folder to prevent any simultaneous processing from taking place. 
The .LCK folder has the same name as the scan job folder. For example, while 
the job MYSCAN is being processed, a MYSCAN.LCK folder is placed in the 
document folder at the same level as MYSCAN.XSM. 

Normally, the .LCK folder is deleted once all processing is completed. However, 
if the .LCK folder is not deleted, it may indicate that the document directory was 
in use at the time the scanner attempted to lock it. 
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For example, if a scanner is shut down right in the middle of a scan job, the lock 
would remain. A scanner knows if it created a lock, so it should recover from its 
own crashes. If a .LCK folder remains in the document folder after a crash, you 
should delete it manually to eliminate this error message. 

! Specified filing Volume name is invalid/incorrect (Netware only).

! Specified filing destination (path) is invalid/incorrect.

! Destination disk is full (preventing the creation of the directory). 

! User does not have Create rights.

! Protocol not running.

The user specified the Scan to Folder operation to a Netware Server, but the 
Netware protocol has not been enabled. (This cannot happen with FTP since the 
TCP/IP protocol currently cannot be disabled.)

! File delete, replace failed.

This can occur when the Overwrite Existing File filing policy is requested. 
During the overwrite operation, attempts to remove files from the document 
folder failed. This can be caused by insufficient access rights or "read only" file 
attributes.

! Filing directory already exists.

This can only occur when the Do Not Save filing policy is used and a document is 
scanned to a document folder which already contains a document of the same 
name. This is the typical behavior of the Do Not Save policy. The scan job is 
aborted.

! Filing service not requested.

A user requests a particular service that is not specified in the distribution 
template. For example, a user submits a fax job but there is no fax filing service 
in the template.
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! Miscellaneous filing error.

This is caused only by failure to read the internal scan to file job TIFF file listing.

! Protocol invalid or not specified.

Retrieval of the network protocol fails. The template properties and the local UI 
should prevent this from occurring. This may occur if the user manually edits a 
job template file and removes or does not specify the filing protocol.

! Login name not specified.

Similar to Protocol invalid or not specified.

! Invalid Netware volume.

Similar to Protocol invalid or not specified.

! Unknown or Invalid.

This should never occur. This is the catch-all error for unexpected occurrences, 
results, or events.

NOTE: The Job list on the Document Centre can also be used to track 
the progress of the Scan Job. Error messages are not displayed, but it 
does indicate if the job has been filed and completed.
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A

Scan Server Configuration and
Access Rights

This section contains detailed information about the network scanning configuration 
directory structure which is created during the scanning installation. It also provides a 
summary of scanning access rights assigned for both NetWare and Windows NT 
networks.
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A-2
The Scanning Configuration Directory 
Structure 
During installation with the Add Network Scanner Wizard, the \CW_SCAN directory 
structure is created on the scan server. The contents of this directory are outlined 
below: 

Bin contains executable files needed for Network Scanning Services.

Config contains configuration files for the Network Scanning Services setup. 
These files include information about the location of repositories (drdf.xst), 
names of groups and the members within them (groups.xst), and data that 
specifies the location of the template pool (jtdf.xst). The scanning applications 
use the information in the Config files to determine the location of scan folders.

Figure 1-1:  Scanning Configuration Directory Structure
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Data contains the scan repositories (document folders) associated with this scan 
server. Within data you will find the Shared, System, and User directories.

! Shared contains any shared document folders. Shared folders are those 
folders accessible to the members of a group. Groups are defined within the 
Add Network Scanner Wizard or the Manage Users dialog. Currently, the 
ability to create groups is available for NetWare and Windows NT (using 
NTFS) installations only. 

! System contains the Public repository (document folder). Public is intended 
to be used as a default repository where scanned documents, whose template 
does not specify a destination repository, will be filed. All scan users have 
read/write access to this repository. 

! Users contains document folders for individual scan users. 

Inbox is a scan repository used to process documents being distributed to E-Mail 
or to other applications’ inboxes. The Distribution Server monitors this 
repository for the arrival of scanned documents and distributes the documents to 
the destination specified in the template.

Services is designed to enable the implementation of future scanning services. 
Currently this directory is not used. 

Template contains the scan templates (the Template Pool). A default Scan to 
PaperPort template is created for each network user specified as a scan user 
during setup with the Scan Admin Wizard. 

The cw_scan.ini is also created during installation and contains the path to the 
\CW_SCAN directory. The cw_scan.ini file resides in the same directory as the 
\CW_SCAN directory. It is not contained within the \CW_SCAN directory.
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Summary of Access Rights

NetWare Networks
The following table summarizes the \CW_SCAN configuration directory structure on 
a NetWare network and defines the access rights for different user groups as they 
relate to different directories within the structure.

Folder/
Directory

User/Group Rights

DCSUsers
Group

Enabled 
Scan Users

User Group

\CW_SCAN R/F R/F

\BIN R/F R/F

\CONFIG R/W/E/C/M/F R/F

\DATA R/W/E/C/M/F R/F

\SHARED R/W/E/C/M/F R/F

\SHARED\Group1 R/W/E/C/M/F R/W/E/C/M/F

\SYSTEM R/W/E/C/M/F R/F

\PUBLIC R/W/E/C/M/F R/W/E/C/M/F

\USERS R/W/E/C/M/F R/F

\USERS\User1 R/W/E/C/M/F R/W/E/C/M/F

\TEMPLATE R/F R/W/E/C/M/F

\INBOX R/W/E/C/M/F

\SERVICES R/W/E/C/M/F R/F

Table 1-1:  NetWare Network Access Rights by User Type
R = Read, W = Write, E = Erase, C = Create, M = Modify, F = FileScan



Windows NT Networks

NTFS

When you install Network Scanning Services to an NTFS partition using the Windows 
NT option within the Add Network Scanner Wizard, CentreWare sets the folder 
permissions within the \CW_SCAN directory structure to all enabled scan users and 
to the account given to the Document Centre. 

Because the folder permissions are filtered by the permissions of the Share, you must 
make sure that the ENABLEDSCANUSERS group has Change access at the Share 
level. Change access enables Read, Write, Execute, and Delete capabilities.

The following table summarizes the \CW_SCAN configuration directory structure on 
a Windows NTFS network and defines the access rights for different user groups as 
they relate to different directories within the structure.

Folder/
Directory

User/Group Rights

DCSUsers
Group

Enabled 
Scan Users

User Group Everyone

\CW_SCAN R/X R/X R/X

\BIN R/X R/X

\CONFIG R/W/X/D R/X

\DATA R/W/X/D R/X R/X

\SHARED R/W/X/D R/X

\SHARED\Group1 R/W/X/D R/W/X/D

\SYSTEM R/W/X/D R/X R/X

\PUBLIC R/W/X/D R/W/X/D R/W/X/D

\USERS R/W/X/D R/X

\USERS\User1 R/W/X/D R/W/X/D

\TEMPLATE R/X R/W/X/D

\INBOX R/W/X/D

\SERVICES R/W/X/D R/X

Table 1-2:  Windows NT Network Access Rights by User Type
R = Read, W = Write, D = Delete, X = Execute
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FAT File Systems

CentreWare does not set folder permissions when installing to a Windows NT FAT 
file partition. You must manually set the permissions of the Share so that enabled scan 
users (ENABLEDSCANUSERS group) can connect to and use the server.

Document Centre Account Network Access Rights

The network account created for the Document Centre requires these additional 
settings:

! Rights to Log on Locally (assigned to the EVERYONE group) 

! Password Never Expires

! User Cannot Change Password



B

Using CentreWare Watch Services
to Scan to PaperPort

This section contains instructions on how to use the CentreWare Watcher to 
automatically scan to PaperPort. The recommended method for scanning to PaperPort 
is to use the Xerox Document Centre Image Retriever which is included in the 
supplemental Scan to PC Desktop™ software package. However, if you wish to use 
CentreWare Watch Services, follow the instructions below.

NOTE: The Xerox Document Centre Image Retriever supports single-page TIFF, 
multi-page TIFF, and PDF formats when scanning to PaperPort. 

The CentreWare Watcher only supports multi-page TIFF. You must select multi-
page TIFF as the output format in the scan distribution template.
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To use the CentreWare Watcher to Scan to the PaperPort desktop:

1 Open the Watch Folder window:

! From the Xerox Network Scanners Folder, click Scanner > Watch Folder.

- OR -

! Right-click the scanning icon in the Windows taskbar, and choose Watch 
Folder.

2 Click Add to open the Add Watch Wizard.

3 Type the path of the folder to watch for scanned documents, and click Next. 

- OR - 

Click Browse and locate the folder on the network. Click OK to close the 
Browse dialog and Next to continue.

4 Select Open with an application and click Next. 

5 Browse to the location of the directory in which PaperPort is installed and select 
the PaperPort executable (paprport.exe). If you performed the typical PaperPort 
installation, the path is: 

C:\Program Files\ScanSoft\PaperPort

6 Click Open. The path and the executable file name appear in the Open With field.



7 Place your cursor at the end of the path in the Open With field. Add a space and 
type /IMPORT or /IMPORTD. 

/IMPORT—imports the scanned documents into PaperPort and also retains the 
files in the document folder.

/IMPORTD—imports the scanned documents into PaperPort and deletes the files 
from the document folder.

Your entry should look like one of the following:

C:\Program Files\ScanSoft\PaperPort\Paprport.exe /IMPORT

C:\Program Files\ScanSoft\PaperPort\Paprport.exe /IMPORTD

8 Click Next.

9 Click Finish to complete the setup.

10 Click OK to close the Watch Folder dialog.
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Glossary

Add Network Scanner Wizard.  A Network Scanning Services software application 
which enables Network Administrators to set up a server to support network 
scanning, manage access to various scanning services, and set up a Document Centre 
to “communicate” with the scan server. Scan users can also use the Wizard to 
automatically discover scanners available to them on the network.

Add Watch Wizard. A Network Scanning Services software component which 
enables users to monitor a document folder for activity. See Watch Services.

\CW_SCAN. The scanning configuration directory structure created on the scan 
server when the Administrator installs Network Scanning Services on a network file 
server. All document folders, the template pool, and associated scanning files are 
contained within the \CW_SCAN directory.

Distribution. A Network Scanning Services term which describes the software’s 
ability to automatically send scanned images or OCR’d documents to E-Mail and 
document management systems.

Distribution Server.  A Windows 95, 98, or NT client, or NT 4.0 server set up to host 
automated document processing. The type of processing that takes place is based on 
the services specified in a distribution template. The distribution server manages 
automated Scan to E-Mail, OCR processing, and scanning to document management 
systems. 
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Distribution Template.  A distribution template is a component of the Network 
Scanning Services software which contains specific instructions on how to create, 
process, or store a network scan job. The information in the template defines various 
scan, OCR, fax, and E-Mail settings that may be required to complete the scan job. 
Templates are stored in a template pool on a network file server. Each user is assigned 
a default template when the Administrator sets up access to network scanning. 

Document Centre.  A multi-function networked machine that is capable of providing 
copying, printing, scanning, and faxing services. Most services can be accessed and 
administered from networked personal computers.

Document Folder.  A document folder is a filing directory on a network server in 
which scanned documents are stored. The scanned documents remain in the document 
folder until they are processed automatically by the Distribution Service or until they 
are retrieved or moved by the Watch Service. A document folder can be monitored by 
only one Network Scanning Services application at a time.

Document Repository.  See Document Folder. 

Filing Policy.  The Filing Policy specifies the method used to store the TIFF images 
in a document folder. The four possible options are outlined below: 

! Overwrite Existing File—deletes any TIFF files stored in the document folder 
before sending the newly scanned files of the same name. All deleted files are 
lost.

! Append to Existing File—adds data from newly scanned files to the existing files 
(of the same name) in the document folder. Existing files are not deleted. Delete 
old files on a regular basis to conserve server space.

! Do Not Save—determines if any files with the same name already exist in the 
document folder. If no files exist, the newly scanned files are sent to the folder. If 
files with the same name already exist in the folder, the scan job is aborted.

! Rename New File—creates a new directory structure (based on the time and date 
of creation) into which the TIFF images are filed. Although this is the safest 
filing policy, it requires a large amount of disk space. (This is the default setting.)

FTP Installations. A term used throughout this book to designate scanning 
installations to an FTP server. Installations to Windows NT FAT partitions, OS/2 
Warp servers, and SUN OS, HP-UX, or AIX systems are all considered FTP 
Installations.
2



History. The history functionality allows network administrators and scan users to 
view the history and status of scan jobs. The History window displays a summary of 
any scan-to-distribution jobs (such as scan to E-Mail, scan to a document folder with 
OCR, or scan to other applications) and information on their status. 

MAPI/MAPI32. An acronym for Microsoft Messaging Application Program Interface. 
MAPI is an electronic mail standard supported by many E-Mail applications. 
MAPI32 refers to 32-bit environments.

Only MAPI32-compliant E-Mail applications, such as Microsoft Exchange, Outlook, 
cc:Mail (version 8+), or MS Internet Mail, are compatible with Network Scanning 
Services. Outlook Express is not MAPI-32 compliant and is not supported.

Multi-page TIFF. See .tif (TIFF).

Network Scanning Services.  A group of CentreWare software applications that 
enable users to convert paper documents to an electronic format. These documents 
can later be stored on a file server, OCR’d, distributed via E-Mail, faxed, or sent 
directly to a PC desktop application without requiring the use of a dedicated scanner 
for each PC. 

Optical Character Recognition.  A technology that analyzes binary (black and 
white) images of character shapes, identifies them as particular alphanumeric 
characters, and outputs them to a text data stream, either in computer memory or to a 
computer file.

PaperPort. An easy-to-use, intuitive interface which enables users to annotate, 
organize, file, and locate scanned documents. PaperPort’s document communication 
features use links to applications which enable users to fax and E-Mail scanned 
documents without leaving PaperPort.

Remote Repository. A remote repository is a scanning file directory, or document 
folder, located outside the scanning directory structure (\CW_SCAN) on the scan 
server. It may be located on the same physical server or on a different server 
altogether. See Also Document Folder.

Repository.  See Document Folder. 
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Scan Server. The network server on which the Network Scanning Services software 
(\CW_SCAN directory) is installed. It typically hosts the scan template pool, a 
document folder for each scan user, a default scanning repository (document folder), 
and group repositories (if groups are supported by the network configuration). 

Service (scanning).  An automated process or type of function performed within 
network scanning. Services are “programmed” or specified within a scan template. 
Available services vary based on the capabilities of your Document Centre scanner 
and which services are installed and enabled on your network. 

Template Pool. A directory location on a network file server (the scan server) in 
which scan templates are stored. Templates created with Network Scanning Services 
are automatically stored to the template pool. 

TextBridge Pro. Optical Character Recognition (OCR) software used to “read” a 
scanned image by analyzing and identifying the text from it. The text is output to an 
electronic file which can later be edited using various word-processing programs. 
Text documents that are scanned but are not processed through OCR become image 
files and cannot be modified.

.tif (TIFF). A file extension for files which contain page images in Tagged Image File 
Format (TIFF), a format commonly used for scanned images. Single-page TIFF is the 
default for Network Scanning Services and must be used for scanning to PaperPort. 
Each page of the original scanned document is transformed into a single TIFF image. 
Multi-page TIFF is available for Scan to E-Mail processing. 

.xst (file). The file extension used to denote a Xerox Scan Template file.
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.xsm (file). A Xerox document storage format designed to simplify integration with 
third-party applications. The .xsm folder contains a collection of TIFF image files, 
data files, and the template file. The .xsm typically contains files such as the 
following: 

! XSMDESC.DAT - An ASCII file which contains the long document name 
(0 - 50 characters).

! <directory name>.DAT - An ASCII list of ordered TIFF file names for the job, 
one name per page. This file has the same name as the .XSM directory. 

! NEXTNAME.DATE - An ASCII file which contains the next available TIFF file 
name. The next name is dependent on the Document Filing Policy designated in 
the scan template. 

! 00000001.TIF, 00000002.TIF (etc.) - The collection of TIFF files from the job. 
The exact name of the file is dependent on the scanning setup. 

! <directory name>.xst - The template used to scan the document. This file has the 
same name as the .XSM directory. 

Watch Services. A component of the Network Scanning Services software which 
enables users to monitor document folders for activity. By using the Add Watch 
Wizard, users can choose from three different automated services that will occur once 
a scanned image is detected in the document folder. The service options include: 
moving the document to another directory, opening the document with a specific 
application, or sending a message to the user’s desktop indicating that a document has 
appeared in the folder.
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